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1  
Introduction 

Receiving Instructions 
Check the equipment received against the packing list to ensure that all materials are 
present. Notify Megger of any shortage. Telephone (610) 676-8500 and ask for the 
Customer Service Department. 

Examine the instrument for damage received in transit. If damage is discovered, file a claim 
with the carrier at once and notify Megger, giving a detailed description of the damage. 

This instrument has been thoroughly tested and inspected to meet rigid specifications 
before being shipped. It is ready for use when set up as indicated in this manual. 

General Information 
The DELTA-3000 is used for shop and field testing of high-voltage electrical insulating 
systems at test voltages up to 12 kV. Test results can be used to evaluate the nature and 
quality of electrical insulating materials and manufacturing processes to reveal 
contamination, fractures, punctures, and other defects that accompany the aging of 
insulation. The test set comprises a control unit, a high-voltage unit, cables, and a canvas 
carrying bag. Refer to the Specifications section for a list of included accessories. 

Tests are made by measuring the capacitance, power factor (dissipation factor) and dielectric 
losses of a specimen. The values measured will change when undesirable conditions exist, 
such as moisture on or in the insulation; shorts or opens in windings or insulation; the 
presence of conductive contaminants in insulating oil, gas or solids; and the presence of 
internal partial discharges. 

The test set measures the capacitance, power factor (dissipation factor) and dielectric losses 
of electrical insulation on high-voltage power equipment such as cables, bushings, 
insulators, circuit breakers, transformers, rotating machines, capacitors, and surge (lightning) 
arresters.  

The test set measures changes of capacitance and dielectric loss due to variations of voltage 
level and ambient conditions, for example, changes in temperature, humidity, pressure, 
mechanical shock, vibration, and stress. Dielectric constant and transformer excitation 
current can also be measured. The test set makes all standard UST and GST tests on high-
voltage apparatus; seven front-panel test mode switches set up test configuration. 
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 Ungrounded specimen test (UST), three positions  

 Grounded specimen test (GST), one position 

 Grounded specimen test using guard connection (GST), three positions 

 Features include: 

 Automatic balance control by high-performance microprocessor. 

 User-friendly operation. 

 Automatic self-checking of test set calibration and operation. 

 Large, easy-to-read full VGA color display 

 Dual low-voltage input cables simplify measurements on multi-winding transformers 
and circuit breakers containing inboard and outboard bushings. 

 Automatic interference suppression circuit ensures trouble-free operation in 
switchyards (up to 765 kV) under electrostatic and magnetic interference conditions. 
The interference suppressor circuit is turned on and off in the preferences screen 
(toggle with space bar). When the interference suppressor circuit is turned on, the 
level of interference is shown on the display. 

 Direct reading of the following quantities: 

 Voltage 

 Capacitance 

 Current at 2.5 kV or 10 kV 

 Percent power factor 

 Percent dissipation factor 

 Watts at 2.5 kV or 10 kV 

 External printer records test data. 

 External personal computer (PC) or laptop can be connected instead of a printer to 
transfer test results. 

 USB memory device and internal memory can store over 1000 test results 
(depending on size) for retrieval and analysis.  Stored data can also be transferred to 
a PC via PowerDB software. 

 Optional bar code wand records equipment identification and temperature. 
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 Two safety interlocks (hand switch or foot switch). 

 Built-in interface to the optional Resonating Inductor provides extended range of 
capacitive measurements. 

 Two-piece design makes the test set easy to transport. 

 Meets the requirements of both the European EMC and Low Voltage Directives. 
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2  
Safety 

Precautions 
The test set and the specimen to which it is connected are a possible source of high-voltage 
electrical energy and all persons making or assisting in tests must use all practical safety 
precautions to prevent contact with energized parts of the test equipment and related 
circuits. Persons actually engaged in the test must stand clear of all parts of the complete 
high-voltage circuit, including all connections, unless the test set is de-energized and all 
parts of the test circuit are grounded. Persons not directly involved with the work must be 
kept away from test activities by suitable barriers, barricades, or warnings. An interlock 
circuit is provided on the control unit of the test set to enable the operator to enclose all 
parts of the complete high-voltage circuit within a secure area. The interlock circuit should 
be used to shut off input power automatically upon unauthorized entry into the high-
voltage area or for any other safety reasons. 

Treat all terminals of high-voltage power equipment as a potential electric shock hazard. 
There is always the potential of voltages being induced at these terminals because of 
proximity to energized high-voltage lines or equipment. Always use a safety ground stick to 
ground the high-voltage conductor. A safety ground jumper must then be installed between 
all terminals of apparatus under test and ground. Always disconnect test leads from power 
equipment before attempting to disconnect them at the test set. The ground connection 
must be the first made and the last removed. Any interruption of the grounding connection 
can create an electric shock hazard. 

This instrument operates from a single-phase power source. It has a three-wire power cord 
and requires a two-pole, three-terminal, live, neutral, and ground type connector. The 
voltage to ground from the live and neutral poles of the power source must be within the 
following rated operating voltage:  

For Cat. No. 673001 120 V ±10%, 60 ±2 Hz 

For Cat. No. 673001-44 120 V ±10%, 50 ±2 Hz 

For Cat. No. 673001-45 230 V ±10%, 60 ±2 Hz 

For Cat. No. 673001-47 230 V ±10%, 50 ±2 Hz 

Before making connection to the power source, determine that the instrument rating 
matches the voltage of the power source and has a suitable two-pole, three-terminal 
grounding connector. 
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The power input plug must be inserted only into a mating receptacle with a ground contact. 
Do not bypass the grounding connection. Any interruption of the grounding connection 
can create an electric shock hazard. Determine that the receptacle is properly wired before 
inserting the plug. 

 For test sets energized with 230 V input, the neutral terminal of the input supply cord 
(white or blue lead) must be connected to the neutral pole of the line power source. The 
ground terminal of the input supply cord (green or yellow/green lead) must be connected to 
the protective ground (earth) terminal of the line power source. The black or brown cord 
lead is the live (hot) lead. 

To avoid electric shock hazard, operating personnel must not remove the instrument from 
the case or remove the protective cover from the power supply. Component replacement 
and internal adjustment must be performed by qualified service personnel. 

The control circuits in all test sets are protected by two mains circuit fuses. These fuses are 
not replaceable by the operator. Refer fuse replacement to qualified service personnel only. 
To avoid electric shock and fire hazard, use only the fuse specified in Section 3, 
Specifications, that is identical in respect to type, voltage rating and current rating. 

It is not possible to eliminate all potential hazards from, and in using, electrical test 
equipment. For this reason, every effort has been made to point out in this instruction 
manual the proper procedures and precautions to be followed by the user in operating this 
equipment and to mark the equipment itself with precautionary warnings where 
appropriate. It is not possible to foresee every hazard which may occur in the various 
applications of this equipment. It is therefore essential that the user, in addition to following 
the safety rules in this manual, also carefully consider all safety aspects of the test before 
proceeding. 

 Safety is the responsibility of the user. 

 Misuse of this high-voltage equipment can be extremely dangerous. 

 The purpose of this equipment is limited to use as described in this manual. Do not 
use the equipment or its accessories with any device other than specifically described. 

 Never connect the test set to energized equipment. 

 Operation is prohibited in rain or snow. 

 Do not use the test set in an explosive atmosphere. 

 A qualified operator should be in attendance at all times while the test equipment is 
in operation. 

 Observe all safety warnings marked on the equipment. 
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 Corrective maintenance must only be performed by qualified personnel who are 
familiar with the construction and operation of the test set and the hazards involved. 

 Refer to IEEE 510 - 1983, “IEEE Recommended Practices for Safety in High-
Voltage and High-Power Testing,” for information. 

If the test equipment is operated properly and all grounds correctly made, test personnel 
need not wear rubber gloves. As a routine safety procedure, however, some users require 
that rubber gloves be worn, not only when making connections to the high-voltage 
terminals, but also when manipulating the controls. Megger considers this an excellent 
safety practice. 

High-voltage discharges and other sources of strong electric or magnetic fields may interfere 
with the proper functioning of heart pacemakers. Persons with heart pacemakers should 
obtain expert advice on the possible risks before operating this equipment or being close to 
the equipment during operation. 

Warning and Caution Notices 
Warning and caution notices are used throughout this manual where applicable and should 
be strictly observed. These notices appear in the format shown below and are defined as 
follows: 

F 
WARNING 

Warning, as used in this manual, is defined as a 
condition or practice which could result in personal 
injury or loss of life. 

 

G 
CAUTION 

Caution, as used in this manual, is defined as a 
condition or practice which could result in damage 
to or destruction of the equipment or apparatus 
under test. 

 



M 
 

 
AVTM673001 Rev F Sept 2008 

8 

 

 

 

 

 

 

 

 

 

 

M 

 



 
AVTM673001 Rev F Sept 2008 

9 

3  
Specifications 

Electrical 
Input Power 

Cat. No. 673001 120 V ac, 60 Hz, 12 A continuous, IEC 1010-1 
installation category II 

Cat. No. 673001-44  120 V ac, 50 Hz, 12A continuous, IEC 1010-1 
installation category II 

Cat. No. 673001-45  230 V ac, 60 Hz, 6 A continuous, IEC 1010-1 
installation category II 

Cat. No. 673001-47  230 V ac, 50 Hz, 6 A continuous, IEC 1010-1 
installation category II 

Protective Devices 

Circuit breaker: 230 V models: 230 V, 15 A, double pole 

120 V models: 230 V, 30 A, double pole 

Fuses (2): IEC designation: Type T, 230 V, 3.15 A 

Output Voltage and Current 

Output voltage range: 0 to 12 kV, continuously adjustable, 200 
mA continuous 

Maximum continuous current: 310 mA for up to 5 minutes. 

The power supply capacity can be extended to 4 A using the optional Resonating Inductor  
(Cat. No. 670600). 

Test Frequency 

Same as line frequency. 
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Measuring Ranges 

Voltage: 250 V to 12 kV, 10 V resolution. 

Minimum recommended voltage is 500 V. 

Current: 0 to 5 A, in 5 ranges, 1μA maximum resolution on low 
range 

The measurement can be corrected to 2.5 kV and 10 kV 
equivalents. 

Capacitance: 1 pF to 1.1μF, 0.01 pF maximum resolution on low ranges 

Dissipation factor:  0 to 200%,  0.01% DF maximum resolution 

Power factor: 0 to 90%, 0.01% PF maximum resolution 

Watts loss:  0 to 2 kW, actual power  

0 to 100 kW when corrected to 10 kV equivalent  

0.1 mW maximum resolution 

The measurement can be automatically corrected to 2.5 kV 
and 10 kV equivalents. 

Accuracy 

Voltage (rms): ±(1% of reading + 1 digit) 

Current (rms):  ±(1% of reading + 1 digit) 

Capacitance: ±(0.5% of reading + 2 pF) in UST mode     ±(0.5% of 
reading + 6 pF) in GST mode 

Dissipation factor: ±(2% of reading + 0.05% DF) 

Power factor:  ±(2% of reading + 0.05% PF) 

Watts loss at 10 kV: ±(2% of reading + 1 mW) 

Measuring Time 

10 to 45 seconds depending on mode of operation 
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Test Modes 

UST;  Ground Red, Measure Blue 

UST;  Ground Blue, Measure Red 

UST;  No Ground, Measure to both Red and Blue 

GST;  Ground Red and Blue 

GST;  Guard Red and Blue, No Grounding 

GST;  Guard Red, Ground Blue 

GST;  Guard Blue, Ground Red 

Cancellation Range and Maximum Interference Conditions 

Automatic interference cancellation circuit ensures trouble-free operation of test set in 
switchyards up to 765 kV, when operated directly under or adjacent to energized lines or 
bus work. 

Magnetic at line frequency: 1000 μT in any direction. 

Available Methods 

 Operator selectable automatic forward/reverse measurement averaging. 

 Operator selectable automatic tracking interference cancellation 

Maximum Measurable Specimen Capacitance 

Table 1 shows the maximum measurable specimen capacitance. This can be increased up to 
1.1 μF at 10 kV test voltage using the optional Resonating Inductor. 

Table 1: Maximum Measurable Specimen 
Capacitance at 50/60 Hz 

 

Test Volts 
Maximum Capacitance (μF) 

(200 mA at continuous service) 

(kV) 60 Hz 50 Hz 

2.5 & less 

4.0 

5.0 

6.0 

0.11 

0.11 

0.11 

0.088 

0.11 

0.11 

0.11 

0.106 
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Table 1: Maximum Measurable Specimen 
Capacitance at 50/60 Hz 

 

Test Volts 
Maximum Capacitance (μF) 

(200 mA at continuous service) 

(kV) 60 Hz 50 Hz 

8.0 

10.0 

12.0 

0.066 

0.052 

0.044 

0.080 

0.062 

0.053 

Safety/EMC/Vibration Qualifications 

Meets the requirements of the European EMC and Low Voltage Directives and ASTM 
D999.75. 

Environmental Conditions 

Operating temperature range: 32° to 122°F (0 to 50C) 

Storage temperature range:  -58° to 140°F  (-50 to 60C) 

Relative humidity: 0 to 90% noncondensing (operating) 

0 to 95% noncondensing (storage) 
 

G 
CAUTION 

Storage for extended periods of time at high 
temperature and relative humidity may cause 
degradation of the LCD. 

Physical Data 
Dimensions and Weight 

Control unit: 16 x 22 x 16 in. (406 x 559 x 406 mm) (H x W x D) 

74 lb (33 kg) 

High-voltage unit: 16 x 22 x 16 in. (406 x 559 x 406 mm) (H x W x D) 

63 lb (29 kg) 

Cables (in bag): Refer to “Accessories Supplied” for individual cable 
lengths. 40 lb (16 kg) max 
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Measuring Circuit 

Based on principle of opposing ampere-turn balance using adjustable transformer ratio arm 
bridge. 

Reference Capacitor 

Fixed loss-free capacitor (fully shielded): 100 pF ±0.5%, 12 kV. 

High-Voltage Transformer 

Double-shielded construction. 

Guarding 

Cold guard type circuit encloses power transformer, reference capacitor, entire high-voltage 
circuit and output test cables. 

Display 

Full VGA color display, 8.4 inches 

Printer 

A battery/line-powered 8.5”x11” (A4) thermal paper USB Pentax printer (or as updated by 
factory via factory installed driver). 

USB Memory Device 

USB Memory device is supplied with the Delta-3000. 

Terminals 

High-voltage 

Low-voltage (2) marked RED and BLUE 

Interconnection (2) 

Resonating Inductor Return 

Supply power 

External interlock (2) 

Ground 

Bar code wand 

USB (host), qty=2 

Ethernet 
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Safety Features 
 Zero start for output voltage. 

 Two external hand interlock switches (supplied) must be closed to energize high-
voltage circuit. 

 Double ground required to energize high-voltage circuit. 

 Circuit breaker for short-circuit protection. 

 All controls at ground potential. 

 Over-voltage protective devices prevent damage to test set in the event of specimen 
breakdown. 

 Low-voltage inputs are grounded when the test set is turned off or between 
measurements. 

Accessories Supplied 
 USB portable thermal printer (120 V) 

 USB portable thermal printer (240 V) 

 PowerDB software, 1st machine license, soft key 

 High voltage lead: 70 ft (21.4 m), double shielded, interchangeable hook or clip 
termination 

 Low voltage leads: 70 ft (21.4 m), shielded (color-coded red and blue) 

 Ground lead: 15 ft (4.6 m) 

 120 volt Power cord: [1] 8 ft (2.5 m) 

 240 volt Power cord: [1] 8 ft (2.5 m) 

 Safety hand switch, Interlock #1:  70 ft (21.4 m) 

 Safety hand switch, Interlock #2:  8 ft (2.5 m) 

 Interconnect cables: For connecting the control and high voltage units, two 5 ft (1.5 
m) 

 Foam transit case: two, foam padded, heavy-duty cases for control and high voltage 
unit 

 Instruction and application manual  
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Optional Accessories 

 PowerDB, 1st machine license, USB dongle  DB1001S 

 HV TTR capacitor (10 nF, 10 kV)   36610 

 HV reference capacitor (100 pF, 10 kV)  36610-1 

 HV reference capacitor (1000 pF, 10 kV)  36610-2 

 Carry case for capacitors    36610-CC 

 Capacitor kit (TTR cap, 2 ref caps, carry case) 36610-KIT 

 Resonating inductor     670600 

 Calibration standard     670500-1 

 Oil test cell      670511 

 Hot collar belts [3]     670505 

 Bushing tap connectors [2]    670506 

 Transit cases for cables  
(heavy-duty, foam-padded)    218744 

 Transit cases for calibration standard  
(heavy-duty, foam-padded)    670635 

 Bar code scanner     36528 

 High voltage lead, 25 ft (7.6 m)   30012-8 

 Thermal paper (8.5” x 11”) for printer   36809-1 

 Thermal paper (A4) for printer    36809-2 

 Replacement/spare battery pack for printer   37077  

 Accessory kit: mini bushing tap connectors [2],  
hot collar straps [3], temperature/humidity meter [1],  
.75” bushing tap connector [1], 1” bushing tap  
connector [1], “J” probe bushing tap connector [1],  
3-ft non-insulating shorting lead [3],  
6-ft non-insulating shorting lead [3]   670501 
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4  
Controls, Indicators, and Connectors 

Control Unit Front Panel (Fig. 1) 

1. GROUND This wing nut is for connecting the test set to earth 
ground. 

2. OPEN GROUND When lit, this yellow lamp indicates an open in 
double ground system or defective grounding of 
test set. 

3. USER 
INTERFACE 
PANEL 

Via the small rubber keypad, the user selects main 
menu icons, moves cursor up or down, selects 
setup for operating mode, etc.  The large 
QWERTY keypad is used for entering 
alphanumeric information. 

4. DISPLAY Display guides the operator through setup and test 
procedures; displays test results and indicates status 
of setup and operating procedures. 

5. POWER This white lamp when lit indicates that the main 
circuit breaker is set to ON and the test set is 
energized. 

6. ON/OFF This two-pole, magnetic main circuit breaker 
controls power to the test set and provides short-
circuit and overload protection. 

7. HIGH VOLTAGE 
ON 

This red lamp when lit indicates that the high-
voltage output circuit is enabled. 

8. HIGH VOLTAGE 
ON 

This white push-button switch, when pressed, 
energizes the high-voltage output circuit and red 
HIGH VOLTAGE lamp when the HIGH 
VOLTAGE CONTROL is set to ZERO START 
and the external interlock switches are closed. 
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Figure 1: Top Panel Controls – Control Unit 

9. HIGH VOLTAGE 
OFF 

This red push-button switch, when pressed, 
immediately de-energizes high-voltage output. It 
may be used as an emergency stop. It turns off the 
red MEASURE and red HIGH VOLTAGE ON 
lamps and clears display test results. 

10. HIGH VOLTAGE 
CONTROL 

Variable-ratio autotransformer adjusts output 
voltage by controlling the primary voltage of the 
high-voltage transformer. This control must be set 
to ZERO START to activate high-voltage output. 

11. OPERATION  Red lamp � When lit, indicates that a 
measurement is being made and high voltage is 
being applied to the test specimen. 

 

F 
WARNING 

High voltage may still be applied to the test 
specimen even when this lamp is not lit. 
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Control Unit Connector Panels (Fig. 2, 3, 4) 

12,13,14 NOT USED  

15, 16. SAFETY INTERLOCK 1 and 2 Two plug receptacles for 
connecting external interlock 
switches. Two hand 
interlock switches are 
supplied; however, in the 
event that a hand interlock is 
replaced with a test area 
interlock, the system must be 
constructed so that the 
interlock switches are closed 
when the test area gate or 
gates are closed. The 
interlock wiring must be run 
as a twisted pair to minimize 
electromagnetic coupling 
into the system. This 
interlock system should be 
wired such that connection is 
made to the A and B sockets 
of the SAFETY 
INTERLOCK receptacle. 
When the interlock loop is 
opened the test is 
automatically terminated. 

17. AC POWER Receptacle for connecting 
the test set to an ac power 
source as marked on panel. 

18. INDUCTOR RETURN Receptacle for connecting 
the test set to an optional 
Resonating Inductor (Cat. 
No. 670600) for extended 
capacitance range. 

19, 20. INTERCONNECT 1 and 2  Two plug receptacles for 
connecting the control unit 
to the high-voltage unit.  
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SAFETY INTERLOCK 
1 

SAFETY INTERLOCK 
2 

120 V, 50 Hz, 12 A 
CONTINUOUS 

INDUCTOR RETURN 
 

INTERCONNECT 1 
 

INTERCONNECT 2 
 

 

Figure 2: Control Unit Connector Panel (Right) 

21. LOW VOLTAGE RED  Plug receptacle for 
connecting the red low-
voltage test lead. 

22. LOW VOLTAGE BLUE Plug receptacle for 
connecting the blue low-
voltage test lead. 

23. NOT USED  

 

Figure 3: Control Unit Connector Panel (Left) 

 Figure 4: Not used 
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High-Voltage Unit Connector Panel (Fig. 5) 
The following connectors are situated behind the door in the front of the high-voltage unit. 

24 NOT USED  

25, 26.  INTERCONNECT 1 and 2 Two plug receptacles for connecting 
the control unit to the high-voltage 
unit. 

27. HV OUTPUT Plug receptacle for connecting the 
high-voltage output cable. 

28. Ground Wing nut terminal for connecting the 
ground pigtail lead of the high-voltage 
output cable. 

INTERCONNECT 2 
HV OUTPUT 

12 Kv, 200 mA 

INTERCONNECT 1 

 

Figure 5: Connector Panel, High-Voltage Unit 
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5  
Setup and Operation 

Safety Precautions 
The output of this test set can be lethal. As with any high-voltage equipment, caution must 
be used at all times and all safety procedures followed. Read and understand Section 2, 
Safety, before proceeding. Be sure that the test specimen is de-energized and grounded 
before making connections. Isolate power equipment to be tested from the high-voltage 
busbars and attach necessary grounds to floating busbars in accordance with standard 
company policy, observing all safety procedures. Make certain that no one can come in 
contact with the high-voltage output terminal or any material energized by the output. Be 
aware that when testing power cables high voltage will be present at the remote end of the 
cable. Use protective barriers if necessary. Locate the control unit and high-voltage unit in 
an area which is as dry as possible.  Maintain adequate clearances between energized 
conductors and ground to prevent arc-over. Such accidental arc-over may create a safety 
hazard or damage the equipment being tested. A minimum clearance of 1 ft (30 cm) is 
recommended. 

Setup 
The following steps are a general guide for setting up the test set. Figure 6 shows a typical 
setup for testing inter-winding and ground capacitance on a three-phase delta-wye power 
transformer; Figure 7 shows a typical setup for making excitation current measurements on 
the same transformer. The test set controls and connectors are identified in Figures 1 
through 5. Refer to the Application Guide for specific instructions on connecting this and 
other power equipment to the test set. 

F 
WARNING 

There is always the possibility of voltages being 
induced at the terminals of a test specimen because 
of proximity to energized high-voltage lines or 
equipment. A residual static voltage charge may also 
be present at these terminals. Ground each terminal 
to be tested with a safety ground stick, then install 
safety ground jumpers, before making connections. 
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G 
CAUTION 

To ensure  proper functioning of the DELTA-3000, it 
is important to avoid exposure of the unit to 
excessive heat. When performing tests on days 
when there is high temperature, keep the DELTA-
3000 in the shade whenever possible. Although the 
DELTA-3000 is rated for operation up to 50°C, in 
direct sunlight the interior of the control unit can 
exceed that temperature, reducing the amount of 
time that the instrument can be used. Turn the 
DELTA-3000 off when not in use. 

 

G 
CAUTION 

Do NOT operate the Delta 3000 without the High 
Voltage cable connected to the High Voltage output 
terminal. 

1. Locate the test set at least 6 ft (1.8 m) from the specimen to be tested. 

2. Connect the wing thumb-nut ground terminal (1) of the test set to a low impedance 
earth ground on the specimen if possible, using the 15 ft (4.5 m) ground cable 
supplied. This should always be the first cable connected. 

3. Connect the control unit receptacle (19, 20) to the high-voltage receptacle (25, 26) 
using the two 5 ft (1.52 m) interconnection cables. Make sure that the bayonet type 
plugs are fully locked on the receptacles. 
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Figure 6: Typical Test Setup for Ac Insulation Testing of a Three-Phase Power Transformer 

DELTA - 3000 

DELTA - 3000 
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Figure 7: Typical Test Setup for Transformer Excitation Current Measurements 

4. Connect the low-voltage cable with the red colored boot to the LOW VOLTAGE 
RED receptacle (21). Make sure the connector locks to the receptacle. If required, 
connect the low-voltage cable with the blue colored boot to the LOW VOLTAGE 
BLUE receptacle (22). 

5. Connect the external interlock cables or a test area interlock system to the SAFETY 
INTERLOCK receptacles (15, 16). Make sure the bayonet type plugs are fully locked 
on the receptacles. 

6. Connect the printer to one of the USB port of the test set if desired.  

7. Connect the bar code wand (optional) to its USB receptacle, if desired. 

8. Connect the high-voltage cable to the high-voltage terminal (27) of the high-voltage 
unit (be sure that the connector locks in place). Connect the pigtail for the outer 
shield to the wing nut terminal (28) (ground) on the high-voltage unit. 

Note: No other connections should be made to terminal (28). 

 

 

DELTA - 3000 
DELTA - 3000 
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Note: The exposed metal shield ring nearest the hook on the outboard end of the high-
voltage cable is at guard potential. The inner metal ring is ground. Both rings are 
undercut so that a battery or alligator clip may be attached to them for convenience 
in connection of short jumper leads to guard or ground. Keep the insulation at each 
end of this cable, as well as the high-voltage plug and receptacle, free from moisture 
and dirt during installation and operation. Clean as required with a clean, dry cloth 
or one moistened sparingly with alcohol. 

9. With the main breaker OFF, plug the input power cord into the test set power 
receptacle (17) and into a three-wire grounded power receptacle having the 
appropriate voltage and current ratings. 

When using a generator as a power source for the DELTA-3000, note the following: 

 The generator itself should be grounded to a suitable earth ground. If this is not 
done properly, the high-voltage circuit of the DELTA-3000 will be disabled. 

 The voltage supplied to the DELTA-3000 should be 120 V ±10% (108 to 132 V). 
For the -47 model, the voltage should be 230 V ±10% (207 to 253 V). Frequency 
stability should be higher than ±2 Hz. Variations of the output voltage shall be less 
than 2 V during any 5 min time interval. 

10. Connect the crocodile clip of the low-voltage test cable to the desired terminal of the 
test specimen. 

11. Connect the hook (or clip) of the high-voltage test cable to the desired terminal of 
the test specimen. 

When making capacitance measurements on transformer windings, always short each 
winding on itself with a jumper lead to eliminate winding inductance effect. When making 
transformer excitation current measurements, conduct all tests on high-voltage windings 
only. This reduces the required charging current. In load tap changers, set to fully raised or 
fully lowered position for routine tests. 
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User Interface Panel 

Test Button: 

 

Initiates and Terminates Testing 

Navigation Keys: 

 

Use Arrow keys to highlight a desired Selection. Use 
Enter button (in center) to Activate the Selection.  

Home Key: 

 

Toggles HOME Action Icons 

Zone Key: 

 

Allows User to select Active area of the screen. 

 
Keypad: Key board for entering notes and data. 

Power Suspend: 

 

Prepares the Instrument for Shutdown. A message will 
indicate when Input Power can be safely removed (not 
used on some models) 

Help Function: 
 

Provides on screen Help to assist operator. 

Information Key: 
 

Provides on screen information to assist operator 

Function Key: 
 

Displays the options available for any highlighted 
Selection (when applicable) 

Figure 8.  User Interface Panel 
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Communications ports 

 Ethernet port 

 USB Storage/Print 

Figure 9.  Communications ports 

HOME Action Icons 

 
Select to create NEW test 

 
Select to RECALL test 

 
Select to SAVE Test. 

 
Select to ZOOM-IN 

 
Select to ZOOM-OUT 

 

Print Icon. Prints the Selected Test Form. Printer driver is factory installed.  Please 
contact Megger for specific printer model availability. 

 
Select to enter PREFERENCES screen 

Figure 10.  HOME Action Icons 
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Utility Icons 

 
Cancel Icon. Select to Cancel without Saving. 

 
Delete Icon. Deletes the Selected File or Report. 

 

Print Icon. Prints the Selected Report. Printer must be standard USB 
supporting HP PCL protocol. 

 

USB Out Icon. Select to Transfer Files or Reports from external USB 
Memory Stick to the TTR. 

 

USB In Icon. Select to Transfer Files or Reports from the TTR to the external 
USB Memory Stick. 

 
Back Icon.  Select to return back to the previous screen. 

Figure 11.  Utility Icons 

Navigating the screen 

  

HOME Screen Action Icons 

 
Select HOME key to display Action Icons  

 

Use ENTER key (in center) to select highlighted action 

Use Arrows keys to highlight desired action 
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Action Icons: 

       

 Select NEW TEST to open new form 

 

Figure 12 New Test Form screen 

Quick test: This setup provides a quick path for single phase 
transformer testing. It requires minimum transformer 
nameplate information to be entered before testing. The 
test results displayed do not include either the calculated 
ratio (per nameplate) or ratio deviation values. 

Quick test with logging: This setup requires entering main transformer nameplate 
information. The “WITH LOGGING” test is used for 
obtaining full test information of a transformer. This setup 
may be saved and recalled later for future testing of the 
same or similar type transformers. 
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QUICK test, example 

  

Figure 13 QUICK test Screen 

 

Figure 14 QUICK TEST WITH LOGGING screen 

Press 

 

TEST to 
initiate testing 

 

Press 

 

TEST to 
initiate testing 
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Select   Recall to open test from memory (either internal or USB memory) 

 

Figure 15. File Manager -Recall Test 

Select  SAVE to save test to memory 

 

Figure 16 File Manager –SAVE Test screen 

 

Use 
 

Zone Key 
to move cursor to 
various zones on display 
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 Select   PREFERENCES to set global parameters 

 

Figure 17 Global Settings – Preferences screen 

 

Owner: User specified field 

SN: Serial Number of Test Instrument 

Units: Units of Measure setting 

Language: Indicates displayed language 

Suppression On: Toggles Noise suppression circuit (use space bar to 
select) 

Save File Prefix: All Saved files will begin with this prefix 

% Error limit: Sets error limit 

Equivalent reading: Sets voltage level to display “equivalent reading” level 

Default form: Indicates default form, upon power-up 

Select   PRINT to print to USB printer 

 

Use 
 

 
Zone Key 
to tab 
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Figure 18 PRINT 

Ac Insulation Test Procedure 
Proceed only after fully understanding Section 2, Safety, and setting up the test set as 
described in Section 5. Refer to Section 4, Controls, Indicators and Connectors, and to 
“Description of Main Menu and Test Screens” in Section 5. Following are the normal 
procedures for conducting a test with print and store functions enabled. 

1. Remove all safety grounds from the specimen to be tested. 

2. To store data, insert a USB memory device into the instrument or the internal 
memory may be used. 

3. Close the main breaker. The white POWER lamp should light. The opening display 
screen appears, and after diagnostic self-check, the test screen is displayed. 

4. Enter temperature 

5. Select the desired LOW VOLTAGE LEAD CONFIGURATION by selecting the 
appropriate UST/GST parameter. 

6. Close the external interlock switches. 

7. Set the HIGH VOLTAGE CONTROL to ZERO START. 

Use SPACE bar to 
select OPTIONs 

 

Use Zone key to tab 
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8. Press the white HV ON push-button switch when ready to energize the high-voltage 
circuit. The red HIGH VOLTAGE ON lamp should light, and the two lightning 
bolt symbol should appear on the screen. 

F 
WARNING 

High voltage is now present at the terminals of the 
test specimen. 

9. Adjust the HIGH VOLTAGE CONTROL to obtain the desired test voltage. The 
test voltage and total current values are shown on the screen.  

Note: If 300 mA is exceeded, the high voltage will shut down. 

10. Once the set-up is completed in the Preferences screen, and the desired form is 
selected, then the TEST may be initiated.  This will light the red operation lamp 
(MEASURE).  When the test is completed, test voltage is removed from the 
specimen and test results are displayed on the screen. The red HIGH VOLTAGE 
ON lamp will remain lit, indicating that the high voltage circuit is still enabled. The 
red operation lamp will be extinguished. 

11. The operator may now choose to conduct another test. 

F 
WARNING 

High voltage is now present at the terminals of the 
test specimen. 

12. When the tests have been completed, return the HIGH VOLTAGE CONTROL to 
the ZERO START position, press the red HIGH VOLTAGE OFF push-button or 
open the external interlock switch, then switch the main breaker to OFF.  

IN CASE OF EMERGENCY 
High-voltage power can be interrupted immediately 
by pressing the red HIGH VOLTAGE OFF push-
button, opening one or both of the external interlock 
switches, or switching the main breaker OFF. 

 

F 
WARNING 

Discharge specimen terminals with a safety ground 
stick to ground all live parts, then solidly ground these 
parts with safety ground jumpers before disconnecting 
the instrument leads. Always disconnect test cables 
from the specimen under test before attempting to 
disconnect them at the test set. The test set ground 
cable should be the last cable disconnected. 
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Transformer Excitation Current Test Procedure 
Proceed only after fully understanding Section, 2, Safety, and setting up the test set as 
described (see Fig. 7).  Refer to Section 4- Controls, Indicators and Connectors and to 
Section 5, Description of Menu and Test Screens. 

To reduce the required charging current, conduct all tests on high-voltage windings only. 
Shorted turns will still be detected in the low-voltage windings. Low-voltage windings which 
are grounded in service (such as Xo) should be grounded for this test. 

Always apply the exact same test voltage to each phase of a three-phase transformer 
winding. This will minimize errors due to any nonlinearity between voltage and current. For 
this same reason, subsequent tests on transformer windings, whether single or three-phase, 
should always be repeated at the exact same test voltage. On three-phase transformers, the 
excitation current is generally similar for two phases and noticeably lower for the third 
phase which is wound on the center leg of the core. 

On single-phase transformers, the winding is normally energized alternately from opposite 
ends. This should also be done on delta windings of three-phase transformers if the 
excitation current is abnormal. The residual magnetism in the magnetic core will seldom 
affect routine tests; however, the probability should be considered if the excitation currents 
are abnormally high. Care should be exercised when energizing transformer windings so as 
not to exceed the voltage rating of the winding. 

Load tap changers should be set to fully raised or fully lowered position for routine tests. 

The following instructions are the normal procedures for conducting a transformer 
excitation current test. 

1. Remove all safety grounds from the specimen to be tested. 

2. Close the main breaker. The white POWER lamp should light.  After a diagnostic 
self-check, the default test screen is displayed. 

3. Not used. 

4. Enter the TEMPERATURE, if desired. 

5. Select the desired LOW VOLTAGE LEAD CONFIGURATION by selecting the 
appropriate UST/GST parameter (UST: Measure Red, Ground Blue, when making 
initial test in accordance with Fig. 7). The lead configuration selected will appear on 
the test screen (UST: MEAS RED, GND BLUE). 

6. Close the external interlock switches. 

7. Set the HIGH VOLTAGE CONTROL to ZERO START. 
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8. Press the white HIGH VOLTAGE ON push button when ready to energize the 
high-voltage circuit. The red HIGH VOLTAGE ON lamp should light, and the two 
lightning bolt symbol should appear on the screen. 

F 
WARNING 

High voltage is now present at the terminals of the 
test specimen. 

9. Adjust the HIGH VOLTAGE CONTROL to obtain the desired test voltage. The 
test voltage and measurement current values are shown on the test screen. 

10. Once the Set-up is performed in the Preferences section, and the desired Test form 
is selected, then Press the TEST button when ready to make a measurement. This 
will light the red operation lamp (MEASURE) and initiate a measurement test (either 
single or continuous, depending on which OPERATION MODE was selected). 
When the test is completed, remove test voltage from the specimen and test results 
are displayed on the screen. After removing test voltage from the specimen, the red 
HIGH VOLTAGE ON lamp extinguish and the red operation lamp will be 
extinguished. 

Note:  The interference suppressor is always turned OFF when making transformer 
excitation current measurements. 

 

Note:  If the total current exceeds 210 mA with a measurement current below the 
maximum, the error message “OVERCURRENT TRIP OUT - PRESS 
ENTER TO CONTINUE” will appear. This may happen when tests are 
conducted on a high-voltage delta winding with the junction between the two other 
windings grounded as shown in Figure 7. 

11. For additional testing, press the TEST button to start the next test. When completed, 
the new test results will be shown on the display. 

12. Repeat steps 7 through 11 as many times as desired to repeat a measurement. 

13. When the tests have been completed, return the HIGH VOLTAGE CONTROL to 
ZERO START, press the red HIGH VOLTAGE OFF push button or open the 
external interlock switch, then switch the main breaker OFF. 

IN CASE OF EMERGENCY 
High-voltage power can be interrupted immediately 
by pressing the red HIGH VOLTAGE OFF push 
button, opening one or both of the external interlock 
switches, or switching the main breaker OFF. 
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F 
WARNING 

Discharge transformer terminals with a safety 
ground stick to ground all live parts, then solidly 
ground these parts with safety ground jumpers 
before disconnecting the instrument leads. Always 
disconnect test cables from the transformer under 
test before attempting to disconnect them at the test 
set. The test set ground cable should be the last 
cable disconnected. 
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6  
Maintenance and Calibration 

Maintenance 
Maintenance should be performed only by qualified persons familiar with the hazards 
involved with high-voltage test equipment. Read and understand Section 2, Safety, before 
performing any service.  

Routine maintenance is all that is required for these test sets. The cables and connector 
panel should be inspected frequently to be sure all connections are tight and all ground 
connections intact. 

The appearance of the test set can be maintained by occasional cleaning of the case, panel 
and cable assemblies. The outside of the carrying case can be cleaned with detergent and 
water. Dry with a clean, dry cloth. The control panel can be cleaned with a cloth dampened 
with detergent and water. Do not allow water to penetrate panel holes, because damage to 
components on the underside may result. A household all-purpose spray cleaner can be 
used to clean the panel. Polish with a soft, dry cloth, taking care not to scratch the display 
screen cover. The cables and mating panel receptacles can be cleaned with isopropyl or 
denatured alcohol applied with a clean cloth. 

Contamination of some parts of the high-voltage circuit, in particular the high-voltage cable 
terminations and its mating panel receptacle, may show up as a residual PF(DF) meter 
reading. Cleaning of these sensitive parts will remove the leakage paths which cause the 
unwanted leakage current. Treat the high-voltage cable with care. Keep it clean and do not 
subject it to abuse, such as dropping or crimping. 

Calibration 
During the warranty period, no calibration should be necessary. Contact the factory if there 
is any suspected problem. 

The overall accuracy of capacitance and power factor (dissipation factor) at 10 kV should 
also be checked at least once a year against Megger’s Capacitance and Dissipation Factor 
Standard (Cat. No. 670500-1). This will ensure that the entire high-voltage circuit is 
functioning and calibrated properly. 
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Troubleshooting 

General Guidelines 

This section provides general guidelines for basic troubleshooting of the DELTA-3000. The 
DELTA-3000 undergoes rigorous testing before being shipped from the factory; however, 
when it is subjected to various field conditions, there is always the possibility of damage 
being done to the instrument or its cables. This troubleshooting section does not attempt to 
cover all possibilities, but does list suggestions that can be carried out in the field. There 
may be problems that require the unit to be returned to the factory for repair. 

If any error messages appear during self-diagnostic check, refer to “Maintenance” and 
“Calibration.” 

If questionable readings are obtained, the first step is to check the calibration of the 
DELTA-3000 using Megger’s Capacitance and Dissipation Factor Standard (Cat. No. 
670500-1). If the standard is not available, the next step is to test a specimen with a known 
value (a specimen that is known to be good). If such a specimen is not available, then 
perform the following procedure for an “Open Air Test.” 

Open Air Test 

The purpose of this test is to check the overall functionality of the DELTA-3000, including 
the high-voltage cable. The readings obtained show the stray signal losses of the high-
voltage cable. 

1. Connect the wing nut ground terminal of the test set to a low impedance earth 
ground using the 15 ft (4.6 m) ground cable supplied. 

2. Connect the control unit receptacles (INTERCONNECT 1 and 2) to the high-
voltage (power supply) receptacles using the two 5 ft (1.5 m) interconnection cables. 

3. Connect the external interlock cables to the SAFETY INTERLOCK receptacles. 

4. Connect the high-voltage cable to the HV OUTPUT terminal of the high-voltage 
unit (power supply). Be sure that the connector locks in place. Connect the pigtail for 
the outer shield to the wing nut terminal (ground). 

G 
CAUTION 

Do NOT operate the Delta 3000 without the High Voltage 
cable connected to the High Voltage output terminal. 
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5. With the main breaker OFF, plug the input power cord into the test set AC POWER 
receptacle and into a three-wire grounded power receptacle having the appropriate 
voltage and current ratings. 

6. Suspend the outboard end of the high-voltage cable in free air so that it is clear of all 
surrounding objects by at least 3 ft (0.91 m). Use dry nylon rope if available. 

7. Close main breaker. Refer to the instructions in Section 5 (Setup and Operation) 
“Description of Menus and Test Screens.” From the first menu screen, choose: 

 Measurement: “AC Insulation Test”; HV Polarity: “Normal/Reverse.” 

 Then choose “EXIT TO TEST.” 

8. Set LOW VOLTAGE LEAD CONFIGURATION to GST GROUND (grounds 
red and blue). Energize high voltage. 

9. Set high voltage to approximately 5 kV. Press MEASURE to start test. 

10. When test is completed, observe test results. The results should be as follows: 

 Capacitance:  between 4.0 and 8.0 pF 

 %DF or %PF:  between -1.0 to +2.0% 

 Watts @ 10 kV: between -0.002 to +0.006 

 mA @ 10 kV:  between 0.015 to 0.030 

Note: The %DF and %PF readings can be affected by high humidity. 

Repair 
Megger offers a complete repair service and recommends that its customers take advantage 
of this service in the event of equipment malfunction. Please indicate all pertinent 
information including problem, symptoms, and attempted repairs. Pack the DELTA-3000 
in its transit case and include all cables that came with the instrument. Equipment returned 
for repair must be shipped prepaid and insured and marked for the attention of the Repair 
Department. 
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7  
Spare Parts List 

Description Part Number 

Cable, ground (hook lug) 4702-7 

Cable, high-voltage 30012-5 

Cable, interconnect 27978 

Cable, interconnect 27979 

Knob (HIGH VOLTAGE CONTROL) 4690-28 

Lead, low-voltage (red) 25572-1 

Lead, low-voltage (blue) 25572-2 

Line cord (for Cat. No. 673001) 17032-4 

Line cord (for Cat. No.  673001-47) 17032-2 

Pilot light, white (1 per unit) 27931-3 

Pilot light, yellow (1 per unit) 27931-4 

Pilot light, red (2 per unit) 27931-5 

Safety interlock hand switch 8 ft (2.4 m) 34460-020 

Safety interlock hand switch 70 ft (21 m) 34460-021 
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Glossary 

G 
Use only in accordance with instruction manual. 

 
Protective conductor terminal is the wing nut for connecting 
the test set to earth ground. 

g 
Earth terminal 

     
  

This two lightning bolt symbol, shown on the Second and 
Third Test Screens (Fig. 15 and 16), indicates that high 
voltage is present. 

arc-over A disruptive discharge in the form of an arc or spark 
between two electrical conductors or between a conductor 
and earth (also sparkover or flashover). 

bridge symbols Bridge symbols used are: R = red, B = blue, and G = green. 

CAP Capacitance 

dissipation factor The ratio of energy dissipated to the energy (DF) stored in 
an element for one cycle. 

GST Grounded specimen test 

hot collar A conductive band used to test for dielectric losses in 
bushings. 

LCD Liquid crystal display 

LED Light-emitting diode 

permittivity The ability of a dielectric to store electrical potential energy 
under the influence of an electric field. 

pothead A device that seals the end of a cable and provides insulated 
egress for the conductor or conductors. 
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power factor (PF) the ratio of total watts to the total rms volt-amperes. 

safety ground 
jumper 

A temporary connection, not supplied, made between the 
terminals of the apparatus under test and ground. 

safety ground 
stick 

An insulated stick (sometimes called a hot stick) with a hook 
type electrode connected to ground via an insulated cable. In 
some designs, frequently known as high voltage discharge 
sticks, a resistor is connected between the electrode and the 
ground cable. Both are used to discharge capacitive 
specimens by providing a low impedance path to ground. 
They must be suitably rated for the voltage and capacitance 
of the specimen to be discharged. 

UST Ungrounded specimen test 
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Delta 2000/3000 PowerDB Lite User Manual 

Introduction 
PowerDB Lite is a free, but limited capability, version of the PowerDB software tool that is 
designed specifically to control and/or extract data from Megger instruments.  The primary 
difference between PowerDB Lite and PowerDB is that PowerDB is designed to work with all 
manufacturers’ equipment and has field and office synchronization capabilities.  PowerDB Lite 
will present your test data into a professional looking data form that can be sent to a printer or 
.pdf file distiller such as PDF995.     

 
PowerDB Lite allows you to use a sub-set of the standard PowerDB forms that are appropriate 
for specific Megger instruments.  PowerDB Lite detects the instrument and enables the 
appropriate form(s).  Data can be entered on-screen or captured directly while using the test 
instrument.  Completed data forms can be saved as files to your computer. 

Minimum Recommended System  

Operating System: Windows 2000 or later 

RAM: 64 MB RAM minimum, 512+ MB RAM recommended  

Processor: 300 MHz Pentium Class processor minimum, 1 GHZ or 
better recommended 

For information about the features of the full version of PowerDB please visit our 
website at www.powerdb.com.  Get acquainted with the following features by scheduling a 
live demonstration at info@powerdb.com. 

 Synchronize All of Your Test Records Into a Single Corporate Database 

 Reduce Test Time 

 Improve Data Integrity 

 Standardize Test Procedures 

 Easily Use Historical Trending for Evaluation of Test Results 

 Eliminates the Need to Install and Maintain a Software Application  per 
Instrument 

 Eliminates All Hand Written Test Sheets 
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 Create Your Own Test Forms 

 Use or Modify One of Our 200 Built-in Test Forms 

 One Step Procedure To Generate Test Reports With Table of Contents and 
Deficiency Summaries 

 Allows All Of Your Field Test Data To Be Integrated With CMMS Systems Such As 
Maximo or SAP 

 Imports >From Many Other Industry Standard Software  Applications 

 Controls and Imports Data From Many non-Megger Instruments 
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Software Installation 
To install PowerDB Lite, load the PowerDB Lite CD into your CD-ROM drive and 
follow the on-screen instructions.   

1. Accept the terms of the License agreement. 

 

2. Choose the destination location for the PowerDB Lite files. 
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3. Select Default Settings.  

 

4. InstallShield Wizard will complete the installation of PowerDB Lite.  Click Finish to 
close the installation program. 
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Using PowerDB Lite  
1. Select your Instrument from the Instrument Setup screen.   

a. You can always view the Instrument Setup screen from the Tools menu or F3.   

b. Select the appropriate row in the Description column. 
Then click the “...” button in the Setup column. 

 

 
c. The Delta 2000 only uses serial communicate, so never check ‘Use Ethernet’ if 

you are using a Delta 2000. Select the appropriate communication settings on the 
Serial Device Configuration screen.  Use the Refresh button to find any ports 
that may have not been connected at the startup of PowerDB Lite.  If you are 
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using a USB serial port and do not know the port assigned to it please perform 
the following. 

a. Remove the USB serial adapter 

b. Press Refresh 

c. Click on the port drop down and record the options 

d. Plug the adapter back in 

e. Press Refresh 

f. Select the port that was not in the original list 

 

Verify that the baud rate is set to 9600, Parity is set to none, Byte Size is set to 8, and 
Stop Bits is set to 1. 

d. The Delta 3000 only uses Ethernet, so make sure ‘Use Ethernet’ is always 
checked if you are using a Delta 3000. Enter the IP address of the Delta 3000 if 
it is known. Leave the IP address empty if it is unknown, and PowerDB Lite will 
automatically detect it. To connect to a Delta 3000 use a network cable to 
connect to the Delta 3000 to the LAN, or use a crossover network cable to 
connect directly to the PC running PowerDB Lite.  

e. Then Click OK on the Instrument Setup Screen to finish 

2. Open a New Form 

a. Select the File>New menu item, or type CTRL+N, or press the New toolbar 

button.  

b. The forms associated with the detected instrument will be shown in the Select a 
Form screen. 
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c. Choose a form by double-clicking or by navigating with the arrow keys and 
pressing the OK button. 

d. Press the F1 key to see Form Help for further instruction on test steps.  

 

3. Enter Test Data 

a. Header and nameplate information can be manually typed into a form. 

b. Click the Initialize Instrument button   to initialize the test set.   

c. Form fields with automation will now be colored cyan. 

d. Right-clicking these fields will start the test. 
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e. To change the settings of the Power Factor test instrument, place the mouse on 
the form and right-click.  Then select “Power Factor Settings”. 

 
f. This dialog box allows you to change the Power Factor settings.  The settings 

that can be changed are as follows: 

1. Show Diagram Number: When enabled this will display a numeric field 
below the winding configuration diagram on the form. The diagram can 
then be changed by entering a number in this field.   

2. Suppression On: Allows you to enable suppression while running a test. 

3. Standard:  This enables you to choose between the ANSI, Australian, or 
IEC Standard.  

4. Equivalent Reading: Allows you to change the equivalent reading from 
Direct, 2.5kV, or 10kV.   

5. Manual Mode: Checks to see if you are using a Delta 2000 with a 
firmware version 5 or less.   

4. Running an Automated Test 

a. Select the Initialize Instrument button.   

b. Automated fields should now turn cyan colored. 

c. Right-click on the cyan colored fields. 

d. Follow the on screen instructions specific to the test. 

5. Comments and Deficiencies 

When imported into the full version of PowerDB, the comments and deficiencies on 
each form are used to generate summary reports.  These summary reports repeat the 
notations and lists the page number where reported.  This allows the user to scroll to a 
particular page to view a reported anomaly.  For more information on features of 
PowerDB visit us at our website at www.PowerDB.com.  
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6. Save the Data 

a. Select the File>Save menu item, or press CTRL+S, or press the Save toolbar 

button.  

b. The Save As screen will allow you to specify a location and file name for your 
PowerDB Lite XML file.  

 

7. Opening an Existing File 

a. Select the File> Open menu item. 

b. Browse to the file you would like to open. Note: Delta 3000 files can be 
transferred via a USB Drive and opened in PowerDB Lite. 

 
c. Press the Open dialog button. 
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d. If the file contains multiple test dates, select the date that you would like to open 
for editing or select New to append a new set of results to the file.  To remove a 
set of results, click on the selected file and press the Delete button. 

 

8. Loading Data Files 

When testing with the Delta 2000 (not Delta 3000) you may import data using a datakey.  
To load these files use the following steps: 

a. Connect the “Datakey Electronics” Datakey reader to the com port that is 
specified on the Delta 2000 Instrument Setup Screen. 

b. Remove Datakey from Delta 2000, and insert it into the Datakey reader and turn 
it to lock it in.  

c. Right-click on a form and select “Import From Datakey”.  PowerDB Lite will 
load the data and present the results for the user to select. 
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9. Setting the Logos 

a. Select the Tools>Options menu item.   

b. The Logos section specifies paths to the left and right logos files to use.  

c. To change the left logo press the “…” button by the left logo path. 

d. The Open screen allows you to browse to a file location, select a .JPG or .BMP 
file, and press the Open button.   

e. Repeat steps (c) and (d) for the right logo path.   

f. Note that a logo will not be shown if the logo file path is blank or the file does 
not exist. 

g. Note after specifying the logo files the image will not be shown until the next 
time a form is opened (File>Open, or the File>New menu items). 

h. Note that the logos will look the best if the resolution of the file is 400 pixels 
wide by 240 pixels high.  DPI is not important. 
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10. How to change Languages  

a. Select the Tools>Options menu item. 

b. Select the appropriate language in the dropdown menu. 

 

11. How to change units of measurement 

a. Select the Tools> Options menu item. 

b. Select the units in the drop down Default Units under Measurements. 
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12. Additional Notes 

a. Additional forms can be filled out by repeating steps 2 through 6.   

b. Forms can be printed with the File>Print menu item, or type CTRL+P, or press 

the Print toolbar button.   

c. A help guide may be found in the Help>PowerDB Lite Help menu item 

Frequently Asked Questions (FAQ’s) 
1. Can I change the forms? 

No.  You must have the full version of PowerDB to change forms.  

2. Can I synchronize forms to a database? 

No.  You must have the full version of PowerDB for database support and to 
synchronize multiple field databases to a single master database. 

3. Can I import PowerDB Lite files into PowerDB? 

Yes.  You can use the File>Import menu item in PowerDB to import files from 
PowerDB Lite.  
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Specific Form Help Instructions 

Operating Instructions for the Power Factor Quick Test Form 

1. Enter the Asset ID 

2. Press the Enter key. 

3. Enter the optional description. 

4. Press the Enter key. 

5. Use the up and down arrow keys to select the type of test. 

6. Press the Enter key. 

7. Use the up and down arrows to turn Suppress on or off. 

8. Hit the Test key (F2). 
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Operating Instructions for the Multiple Power Factor Quick Test Form 

1. Enter the Asset ID. 

2. Press the Enter jey. 

3. Use the up and down arrows to turn Suppress on or off.   

4. Press the Enter key. 

5. Enter the description under Insulation Tested.   

6. Hit the Enter key.   

7. Select the type of test under Test Lead Configuration.   

8. Hit the Test key (F2). 

9. Repeat steps 5 through 8 for subsequent tests.   
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1  
Introduction 

General 
The intention of this section is to guide the operator in the appropriate method of 
making capacitance and dissipation factor measurements on power apparatus and to 
assist in the interpretation of test results obtained. It is not a complete step-by-step 
procedure for performing tests. 

F 
WARNING 

Specific instructions in the operation of the test set, 
making connection to the apparatus under test, and 
safety precautions to be observed are not included. 

Before performing any test with this apparatus, read and understand Section 2, Safety, and 
observe all safety precautions indicated throughout this manual. In addition, before 
performing any field tests, refer to IEEE 510 - 1983, “IEEE Recommended Practices for 
Safety in High-Voltage and High-Power Testing” for more information. 

Principle of Operation 
Most physical capacitors can be accurately represented as a two or three-terminal network 
as shown in Figure 1. The direct capacitance between the terminals H and L is represented 
by CHL while the capacitances between each respective terminal and ground are represented 
by CHG and CLG. In the two-terminal capacitor the L terminal is connected to ground. 

An example of a two-terminal capacitor is an apparatus bushing. The center conductor is 
one terminal and the mounting flange (ground) is the second terminal. An example of a 
three-terminal capacitor is an apparatus bushing which has a power factor or capacitance 
tap. The center conductor is one terminal, the tap is the second terminal, and the mounting 
flange (ground) is the third terminal. 

It is possible to have a complex insulation system that has four or more terminals. A direct 
measurement of any capacitance component in a complex system can be made with this test set 
since it has the capability for measuring both ungrounded and grounded specimens. 

Figure 2 shows a simplified measuring circuit diagram of the DELTA-3000 test set when 
operating in the UST test mode. The basic bridge circuit uses a three-winding differential 
current transformer. The ampere-turns due to the current iX through the test specimen (CHL) are 
balanced by the ampere-turns due to the current is passing through the reference capacitor (CS). 
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The same voltage is applied to the two capacitors by the power supply. An ampere-turn balance 
is obtained for the quadrature (capacitance) component of current by automatic adjustment of 
the NX and NS turns. The value of the capacitance is then displayed on the LCD. 

Since the specimen current includes both an in-phase component (leakage) and a quadrature 
component (capacitive) of current, a residual difference current will appear in the third winding 
after the capacitance has been balanced. This represents the leakage (loss) component of 
current. This current component is also automatically balanced to produce a dissipation factor 
(power factor/watts/milliwatts) balance. The % dissipation factor/power 
factor/watts/milliwatts is displayed on the LCD.  

Figure 2 also shows how guarding is accomplished in the UST test mode. The bridge measures 
the capacitance CHL which is shown by the heavy solid line. All internal and external stray 
capacitance between the high-voltage H terminal and guard (ground) shunts the power supply, 
where it affects only the supply loading and does not influence the measurement. All stray 
capacitance between the L terminal and guard (ground) shunts the NX bridge winding and also 
does not influence the measurement. In practice the transformer winding resistance and leakage 
inductance is very small so that a large value of capacitance (>2000 pF) can be allowed to shunt 
the NX bridge winding before there is a noticeable error in the measurement. 

 

Figure 1: Two and Three Terminal Capacitors 
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Figure 2: Simplified Measuring Circuit Diagram, UST MEASURE RED Test Mode 

Figure 3 shows the measuring circuit and guarding for the GST GROUND RED test 
mode. In this test the L terminal of the specimen is grounded (two-terminal specimen). 
The bridge measures the two capacitances shown by the heavy solid lines (CHL + CHG). 
All internal stray capacitance between the high-voltage lead and guard shunts the power 
supply, whereas the stray capacitance between guard and ground shunts the NX bridge 
winding, therefore, both internal stray capacitances are excluded from the measurement 
for the same reasons as for the UST test method. 

Figure 4 shows the measuring circuit and guarding for the GST GUARD RED test 
mode. The bridge measures the capacitance shown by the heavy solid line (CHG). All 
internal and external stray capacitance between the high-voltage H terminal and guard 
shunts the power supply, whereas all internal and external stray capacitance between 
guard and ground shunts the NX bridge winding; therefore, both stray capacitances are 
excluded from the measurement. 

Current, Capacitance and Dissipation Factor Relationship 
In an ideal insulation system connected to an alternating voltage source, the capacitance 
current Ic and the voltage are in perfect quadrature with the current leading. In addition 
to the capacitance current, there appears in practice a loss current Ir in phase with the 
voltage as shown in Figure 5. 
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The current taken by an ideal insulation (no losses, Ir = 0) is a pure capacitive current 
leading the voltage by 90° (θ = 90°). In practice, no insulation is perfect but has a certain 
amount of loss and the total current I leads the voltage by a phase angle θ (θ< 90°). It is 
more convenient to use the dielectric-loss angle δ, where δ = (90° - θ). For low power 
factor insulation Ic and I are substantially of the same magnitude since the loss 
component Ir is very small. 

The power factor is defined as: 

Power factor =    =    =  I
I

rcos sinΘ δ  

and the dissipation factor is defined as: 

Dissipation factor =  t =    =  I
I

r

c
co tanΘ δ  

The DELTA-3000 test set is calibrated for direct reading in terms of capacitance and 
dissipation factor (tan δ). 

 

 

Figure 3: Simplified Measuring Circuit Diagram, GST GROUND RED Test Mode 
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Figure 4: Simplified Measuring Circuit Diagram, GST GUARD RED Test Mode 

 

Figure 5: Vector Diagram Insulation System  
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Figure 6: Vector Diagram Showing Resistance and Reactance  

The important characteristic of a capacitor is the ratio of its loss resistance to its 
reactance, which is the dissipation factor. This relationship is shown in the vector 
diagram of Figure 6. 

In cases where angle δ is very small, sin δ practically equals tan δ. For example, at power 
factor values less than 10 percent the difference will be less than 0.5 percent of reading 
while for power factor values less than 20 percent the difference will be less than 2 
percent of reading. 

The value of Ic will be within 99.5 percent of the value I for power factor (sin δ) values 
up to 10 percent and within 98 percent for power factor values up to 20 percent. 

If it is desired to find the value of the charging current Ic at a given test voltage and 
frequency, it may be determined from the following relationship: 

 Ic = VωC 

In reality, a capacitor possesses both a series and parallel loss resistance as shown in 
Figure 7. The frequency of the applied voltage determines which loss dominates, 
however, at low frequencies (50/60 Hz) only the parallel losses Rp, predominately 
generated in the dielectric, are generally measured. For a particular frequency, any loss 
can be expressed in terms of either a series or parallel equivalent circuit with equal 
accuracy. The choice is a matter of convenience. The dissipation factor (tan δ) for the 
series equivalent circuit is defined as: 

 tan δ = Rs ω Cs 

To find the equivalent parallel impedance Cp and Rp, use the conversion formulas shown 
in Figure 8. 

tanδ ω= =
R
X

R C
c

X
Cc =
1

ω
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Figure 7: Equivalent Circuit for Capacitor Losses 

 

Figure 8: Series - Parallel Equivalent Circuit 

Conversion Formulas 

Note: Capacitance, dissipation factor, power factor, watts, watts at 10 kV, watts at 
2.5 kV, current, current at 10 kV, and current at 2.5 kV can all be read 
directly from the DELTA-3000 test set. These formulas are provided for 
informational purposes only. 

Use the following formulas and the chart in Figure 9 to compare the capacitance reading 
obtained on the DELTA-3000 test set against the milliampere reading as well as the 
DELTA-3000 test set dissipation factor reading versus the watts loss reading. The mA 
and mW readings, even if obtained at reduced test voltages, are generally recorded in 
terms of equivalent 2.5 kV values (2.5 kV test set) or equivalent 10 kV values (10 kV test 
set). 

)CR(+1
C = 

+1
C = C 2

ss

s

s
2

s
p ωδtan

CR
1 =  

pp ω
δtan

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
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1+1 R = 1+1 R = R 2
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s
s
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Conversion Formulas for Test at 2.5 kV, 60 Hz 

(based on equivalent 2.5 kV values) 

 

Conversion Formulas for test at 10 kV, 60 Hz 

(based on equivalent 10 kV values) 

 

CpF  = mA x 265 
 
mA  = CpF x 377 x 10-5  

mA
 x W%DF = loss 10  

Wloss = CpF x %DF x  377 x10-6   

Applicable when DF (PF) 
is less than 20 percent 

No limitation

CpF  = mA x 1061 
 
mA  = CpF x 94.3 x 10-5  

%DF =  W  x 40
mA

loss  

Wloss = CpF x %DF x 23.6 x10-6   

Applicable when DF (PF) 
is less than 20 percent 

No limitation
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Figure 9: Graph for Converting Power Factor vs. Dissipation Factor Above 20% 
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Conversion Formulas for test at 2.5 kV, 50 Hz 

(based on equivalent 2.5 kV values) 

 

Conversion Formulas for test at 10 kV, 50 Hz 

(based on equivalent 10 kV values) 

 

CpF  = mA x 318 
 
mA  = CpF x 314 x 10-5  

mA
 x W%DF = loss 10  

Wloss = CpF x %DF x 314 x10-6   

Applicable when DF (PF) 
is less than 20 percent 

No limitation

CpF  = mA x 1273 
 
mA  = CpF x 78.6 x 10-5  

mA
 x W%DF = loss 40  

Wloss = CpF x %DF x 19.6 x10-6   

Applicable when DF (PF) 
is less than 20 percent 

No limitation
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General Conversion Formulas 

 
where: 

CpF = capacitance, picofarads 

DF = dissipation factor 

mA = milliamperes 

PF = power factor 

kV  = kilovolts 

ω  = 2πf 

Wloss = watts loss  

f  = frequency 

Applicable when DF (PF) 
is less than 20 percent 

No limitation

CpF  = mA x 10 6 
              ϖ kV 
 
CpF  = mA x 2650   @ 60 Hz 
                kV 
 
CpF  = mA x 3180   @ 50 Hz 
                kV 
 
mA  = kV ω CpF x 10- 
 
mA  = kV x CpF x 377 x 10-6  @ 60 Hz 
 
mA  = kV x CpF x 314 x 10-6  @ 50 Hz 
 

%DF =  W  x 100
kV x mA

loss  

 
Wloss = kV2 x CpF x %DF x 3.77 x 10-6  @ 60 Hz 
 
Wloss = kV2 x CpF x %DF x 3.14 x 10-6  @ 50 Hz 
 
 

PF DF
DF

=
+1 2

 

 
 

DF =  PF
1 PF− 2

 

No limitation
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Connections for UST/GST Low Voltage Lead Configuration 
Figures 10 through 13 show the connections between the test set and specimen for each 
of the UST/GST low voltage lead configurations. The following chart shows the 
connections of the low voltage red and blue test leads for a measurement and to either 
guard or ground in the bridge circuit. It also provides cross-reference to the existing 
MEGGER Biddle test sets. The component measured is shown by the heavy solid line in 
Figures 10 through 13. Measurements are always made between the black high-voltage 
lead and the lead in the MEASURES column. For the GST test mode, measurement is 
also made between the high voltage lead and ground. 

DELTA-3000  Test Set (Cat. 
No. 673001) 

TEST MODE POSITION 

(Cat. No. 670025, 670065, 670070)  

UST 

GROUNDS MEASURES  

⎯ RED & BLUE 1 

BLUE RED 3 

RED BLUE 2 

GST GROUND 

 GROUNDS  

 RED & BLUE 4 

GST 

GUARDS GROUNDS  

RED & BLUE ⎯ 5 

RED BLUE 7 

BLUE RED 6 
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Figure 10: Connection for Three-Phase Specimens 
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Figure 11: Connection for Four-Terminal Specimens, UST Test Modes 
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 5 

 

Figure 12: Connection for Four-Terminal Specimens, GST Test Modes 



M 
 

 
AVTM673001 Rev F Sept 2008 

84 

 6 

 

Figure 13: Connection for Four-Terminal Specimen, GST Guard Modes 
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2  
Interpretation of Measurements 

Significance of Capacitance and Dissipation Factor 
A large percentage of electrical apparatus failures are due to a deteriorated condition of 
the insulation. Many of these failures can be anticipated by regular application of simple 
tests and with timely maintenance indicated by the tests. An insulation system or 
apparatus should not be condemned until it has been completely isolated, cleaned, or 
serviced and measurements compensated for temperature. The correct interpretation of 
capacitance and dissipation factor tests generally requires a knowledge of the apparatus 
construction and the characteristics of the particular types of insulation used. 

Changes in the normal capacitance of an insulation indicate such abnormal conditions as 
the presence of a moisture layer, short circuits, or open circuits in the capacitance 
network. Dissipation factor measurements indicate the following conditions in the 
insulation of a wide range of electrical apparatus: 

 Chemical deterioration due to time and temperature, including certain cases of acute 
deterioration caused by localized overheating. 

 Contamination by water, carbon deposits, bad oil, dirt and other chemicals. 

 Severe leakage through cracks and over surfaces. 

 Ionization. 

The interpretation of measurements is usually based on experience, recommendations of 
the manufacturer of the equipment being tested, and by observing these differences: 

 Between measurements on the same unit after successive intervals of time. 

 Between measurements on duplicate units or a similar part of one unit, tested under 
the same conditions around the same time, e.g., several identical transformers or one 
winding of a three-phase transformer tested separately. 

 Between measurements made at different test voltages on one part of a unit; an 
increase in slope (tip-up) of a dissipation factor versus voltage curve at a given 
voltage is an indication of ionization commencing at that voltage. 

An increase of dissipation factor above a typical value may indicate conditions such as 
those given in the previous paragraph, any of which may be general or localized in 
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character. If the dissipation factor varies significantly with voltage down to some voltage 
below which it is substantially constant, then ionization is indicated. If this extinction 
voltage is below the operating level, then ionization may progress in operation with 
consequent deterioration. Some increase of capacitance (increase in charging current) 
may also be observed above the extinction voltage because of the short circuiting of 
numerous voids by the ionization process. 

An increase of dissipation factor accompanied by a marked increase in capacitance 
usually indicates excessive moisture in the insulation. Increase of dissipation factor alone 
may be caused by thermal deterioration or by contamination other than water. 

Unless bushing and pothead surfaces, terminal boards, etc., are clean and dry, measured 
quantities may not necessarily apply to the volume of the insulation under test. Any 
leakage over terminal surfaces may add to the losses of the insulation itself and may, if 
excessive, give a false indication of its condition. 

Dissipation Factor (Power Factor) of Typical Apparatus 
Insulation 

Values of insulation dissipation factor for various apparatus are shown in Table 1. These 
values may be useful in roughly indicating the range to be found in practice; however, 
the upper limits are not reliable service values. Dissipation factor has a direct advantage 
over an equivalent watts value since it is independent of the insulation thickness and 
area. The dielectric watts loss increases as the amount of insulation under test increases. 

Table 1: DF (PF) of Typical Apparatus Insulation 

Type Apparatus % DF (PF) at 20°C 

Oil-filled transformer: New, high-voltage (115 kV and up) 

15 years old, high-voltage 

Low-voltage, distribution type 

0.25 to 1.0 

0.75 to 1.5 

1.5 to 5.0 

Oil circuit breakers 0.5 to 2.0 

Oil-paper cables, “solid” (up to 27.6 kV) new condition 0.5 to 1.5 

Oil-paper cables, high-voltage oil-filled or pressurized 0.2 to 0.5 

Rotating machine stator windings, 2.3 to 13.8 kV 2.0 to 8.0 

Capacitors (discharge resistor out of circuit) 0.2 to 0.5 

Bushings: Solid or dry 

Compound-filled, up to 15 kV 

Compound-filled, 15 to 46 kV 

Oil-filled, below 110 kV 

Oil-filled, above 110 kV and condenser type 

3.0 to 10.0 

5.0 to 10.0 

2.0 to 5.0 

1.5 to 4.0 

0.3 to 3.0 
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Permittivity and % DF of Typical Insulating Materials 
Typical values of permittivity (dielectric constant) k and 50/60 Hz dissipation factor of a 
few kinds of insulating materials (also water and ice) are given in Table 2. 

Table 2: Permittivity of Typical Insulating Materials 

Material k % DF (PF) at 20°C 

Acetal resin (Delrin*) 3.7 0.5 

Air 1.0 0.0 

Askarels 4.2 0.4 

Kraft paper, dry 2.2 0.6 

Oil, transformer 2.2 0.02 

Polyamide (Nomex*) 2.5 1.0 

Polyester film (Mylar*) 3.0 0.3 

Polyethylene 2.3 0.05 

Polyamide film (Kapton*) 3.5 0.3 

Polypropylene 2.2 0.05 

Porcelain 7.0 2.0 

Rubber 3.6 4.0 

Silicone liquid 2.7 0.01 

Varnished cambric, dry 4.4 1.0 

Water** 80 100 

Ice** 88 1.0 (0°C) 

* Dupont registered trademark. 

** Tests for moisture should not be made at freezing temperatures because of the 100 to 
1 ratio difference of % dissipation factor between water and ice. 

Significance of Temperature 
Most insulation measurements have to be interpreted based on the temperature of the 
specimen. The dielectric losses of most insulation increase with temperature. In many 
cases, insulations have failed due to the cumulative effect of temperature, i.e., a rise in 
temperature causes a rise in dielectric loss which in turn causes a further rise in 
temperature, etc. 
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It is important to determine the dissipation factor-temperature characteristics of the 
insulation under test, at least in a typical unit of each design of apparatus. Otherwise, all 
tests of the same specimen should be made, as nearly as practicable, at the same 
temperature. On transformers and similar apparatus, measurements during cooling (after 
factory heat-run or after service load) can provide the required temperature correction 
factors. For circuit breakers and other apparatus in which little heating occurs in service, 
measurements to determine correction factors can be made at different but constant 
ambient conditions. 

To compare the dissipation factor value of tests made on the same or similar type 
apparatus at different temperatures, it is necessary to convert the value to a reference 
temperature base, usually 20°C (68°F). Tables of multipliers for use in converting 
dissipation factors at test temperatures to dissipation factors at 20°C are found in 
Appendix D. 

The test temperature for apparatus such as spare bushings, insulators, air or gas filled 
circuit breakers, and lightning arresters is normally assumed to be the same as the 
ambient temperature. For oil-filled circuit breakers and transformers the test temperature 
is assumed to be the same as the oil temperature. For installed bushings where the lower 
end is immersed in oil the test temperature lies somewhere between the oil and air 
temperature. 

In practice, the test temperature is assumed to be the same as the ambient temperature 
for bushings installed in oil-filled circuit breakers and also for oil-filled transformers that 
have been out of service for approximately 12 hours. In transformers removed from 
service just prior to test, the temperature of the oil normally exceeds the ambient 
temperature. The bushing test temperature for this case can be assumed to be the 
midpoint between the oil and ambient temperatures. 

Any sudden changes in ambient temperature will increase the measurement error since 
the temperature of the apparatus will lag the ambient temperature. The capacitance of 
dry insulation is not appreciably affected by temperature; however, in the case of wet 
insulation, there is a tendency for the capacitance to increase with temperature. 

Dissipation factor-temperature characteristics, as well as dissipation factor measurements 
at a given temperature, may change with deterioration or damage of insulation. This 
suggests that any such change in temperature characteristics may be helpful in assessing 
deteriorated conditions. 

Be careful making measurements below the freezing point of water. A crack in an 
insulator, for example, is easily detected if it contains a conducting film of water. When 
the water freezes, it becomes nonconducting, and the defect may not be revealed by the 
measurement, because ice has a volumetric resistivity approximately 100 times higher 
than that of water. Tests for the presence of moisture in solids intended to be dry should 
not be made at freezing temperatures. Moisture in oil, or in oil-impregnated solids, has 
been found to be detectable in dissipation factor measurements at temperatures far 
below freezing, with no discontinuity in the measurements at the freezing point. 
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Insulating surfaces exposed to ambient weather conditions may also be affected by 
temperature. The surface temperature of the insulation specimen should be above and 
never below the ambient temperature to avoid the effects of condensation on the 
exposed insulating surfaces. 

Significance of Humidity 
The exposed surface of bushings may, under adverse relative humidity conditions, 
acquire a deposit of surface moisture which can have a significant effect on surface 
losses and consequently on the results of a dissipation factor test. This is particularly true 
if the porcelain surface of a bushing is at a temperature below ambient temperature 
(below dew point), because moisture will probably condense on the porcelain surface. 
Serious measurement errors may result even at a relative humidity below 50 percent 
when moisture condenses on a porcelain surface already contaminated with industrial 
chemical deposits. 

It is important to note that an invisible thin surface film of moisture forms and dissipates 
rapidly on materials such as glazed porcelain which have negligible volume absorption. 
Equilibrium after a sudden wide change in relative humidity is usually attained within a 
matter of minutes. This, however, excludes thicker films which result from rain, fog, or 
dew point condensation. 

Surface leakage errors can be minimized if dissipation factor measurements are made 
under conditions where the weather is clear and sunny and where the relative humidity 
does not exceed 80 percent. In general, best results are obtained if measurements are 
made during late morning through mid afternoon. Consideration should be given to the 
probability of moisture being deposited by rain or fog on equipment just prior to making 
any measurements. 

Surface Leakage 
Any leakage over the insulation surfaces of the specimen will be added to the losses in 
the volume insulation and may give a false impression as to the condition of the 
specimen. Even a bushing with a voltage rating much greater than the test voltage may 
be contaminated enough to cause a significant error. Surfaces of potheads, bushings, and 
insulators should be clean and dry when making a measurement. 

It should be noted that a straight line plot of surface resistivity against relative humidity 
for an uncontaminated porcelain bushing surface results in a decrease of one decade in 
resistivity for a nominal 15 percent increase in relative humidity and vice versa. 

On bushings provided with a power factor or capacitance tap, the effect of leakage 
current over the surface of a porcelain bushing may be eliminated from the measurement 
by testing the bushing by the ungrounded specimen test (UST). 

When testing bushings without a test tap under high humidity conditions, numerous 
companies have reported that the effects of surface leakage can be substantially 



M 
 

 
AVTM673001 Rev F Sept 2008 

90 

minimized by cleaning and drying the porcelain surface and applying a very thin coat of 
Dow Corning #4 insulating grease (or equal) to the entire porcelain surface. When 
making a hot collar test, the grease is generally only applied to the porcelain surface on 
which the hot collar band is to be located and to that of one petticoat above and one 
below the hot collar band. 

When testing potheads, bushings (without test tap), and insulators under unfavorable 
weather conditions, the dissipation factor reading may, at times, appear to be unstable 
and may vary slightly over a very short period of time. The variation is caused by such 
factors as the amount of surface exposure to sun or shade, variations in wind velocity, 
and gradual changes in ambient temperature and relative humidity. Similar bushings may 
have appreciably different dissipation factor values for the case where one bushing is 
located in the sun while the other is in the shade. A test made on the same bushing may 
have a different dissipation factor value between a morning and an afternoon reading. 
Due consideration must be given to variations in readings when tests are made under 
unfavorable weather conditions. 

Electrostatic Interference 
When tests are conducted in energized substations, the readings may be influenced by 
electrostatic interference currents resulting from the capacitance coupling between 
energized lines and bus work to the test specimen. In the shop or low-voltage 
substations the effects of electrostatic interference currents can be canceled by taking 
normal and reverse polarity voltage readings. In high-voltage substations the effects of 
electrostatic interference currents can be canceled by using the interference suppressor 
circuit. Normal and reverse polarity voltage readings should still be taken to cancel any 
residual interference currents. Trouble from magnetic fields encountered in high-voltage 
substations is very unlikely. 

To counter the effects of severe electrostatic interference on the measurement, it may be 
necessary to disconnect the specimen from disconnect switches and bus work. 
Experience in making measurements will establish the particular equipment locations 
where it is necessary to break the connections. The related disconnect switches, leads 
and bus work, if not energized, should be solidly grounded to minimize electrostatic 
coupling to the test set. 

The measurement difficulty which is encountered when testing in the presence of 
interference depends not only upon the severity of the interference field but also on the 
capacitance and dissipation factor of the specimen. Unfavorable weather conditions such 
as high relative humidity, fog, overcast sky, and high wind velocity will increase the 
severity and variability of the interference field. The lower the specimen capacitance and 
its dissipation factor, the greater the difficulty, with possible reduction in accuracy, in 
making measurements. It is also possible that a negative dissipation factor reading may 
be obtained so it is necessary to observe the polarity sign for each reading. Specifically, it 
has been found that some difficulty may be expected when measuring capacitance by the 
GST test method in 230 through 550 kV low-profile switchyards when the capacitance 
value is less than 100 pF. This difficulty may be minimized considerably by: 
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 Using the maximum voltage of the test set if possible. 

 Disconnecting and grounding as much bus work as possible from the specimen 
terminals. 

 Making measurements on a day when the weather is sunny and clear, the relative 
humidity is less than 80 percent, the wind velocity is low, and the surface 
temperature of exposed insulation is above the ambient temperature. 

Tests made by the UST method are less susceptible to interference pickup than are tests 
made by the GST method. In the UST test method, the capacitive coupled pickup 
current in the high-voltage circuit flows directly to ground after having passed through 
the high-voltage winding of the power supply transformer. In the GST test method the 
same pickup current, after passing through the high-voltage transformer winding, must 
pass through one of the bridge transformer-ratio measuring arms before reaching 
ground. 

It is not generally recognized that when testing by the GST test method in the vicinity of 
other energized high-voltage circuits another form of interference is produced which 
may cause a change in the actual dissipation factor of the specimen. This interference is 
partial discharge that may occur at the specimen high-voltage terminal, not as a result of 
the test voltage, but by intense fields between the specimen terminal and the adjacent 
energized high-voltage circuit. The partial discharge loss resulting from this interference 
is added to the normal loss in the specimen, thereby increasing its dissipation factor. 
Since this type of interference is a loss related to the specimen in that particular 
environment, it cannot be eliminated from the test and cannot be considered as an error 
in the measurement. 

If the test set is energized from a portable generator when conducting tests in an 
energized substation, the readings may fluctuate over a significant range. This results 
from the frequency of test set voltage being out of synchronization with the electrostatic 
interference field. If it is not possible to synchronize the frequency of the two voltage 
systems, disconnect and ground as much bus work as possible from the specimen 
terminals. This will decrease both the interference pickup and the reading fluctuation. 

Negative Dissipation Factor 
In isolated cases, negative dissipation factors are encountered in the measurement of 
dielectric specimens of low capacitance. This condition is most likely to arise when 
making UST and GST measurements on specimens which have a capacitance value of a 
few hundred picofarads or less. Equipment such as bushings, circuit breakers, and low 
loss surge arresters fall into this category. 

It is believed that the negative dissipation factor phenomenon is caused by a complex tee 
network of capacitance and resistance which exists within a piece of equipment. Error 
currents may flow into the measuring circuit in instances where phantom multiple 
terminals or a guard terminal appear in the measurement system. It is also believed that a 
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negative dissipation factor may be produced by error currents flowing into a tee network 
as a result of space coupling from electrostatic interference fields. 

The only time a negative dissipation factor has been observed is in cases where there is 
incomplete shielding of the measuring electrode or when the specimen itself is defective. 

The error is usually accentuated if tests are influenced by strong interference fields or are 
made under unfavorable weather conditions, especially a high relative humidity which 
increases surface leakage. 

There appears to be no clear-cut way of knowing whether an error is significant or what 
remedies should be taken to overcome an error. The best advice is to avoid making 
measurements on equipment in locations where negative dissipation factors are known 
to present a problem when unfavorable weather conditions exist, especially high relative 
humidity. Make sure the surface of porcelain bushings are clean and dry to minimize the 
effects of surface leakage. Make sure all items such as wooden ladders or nylon ropes are 
removed from the equipment to be tested and are brought out of any electrostatic 
interference fields that could influence a measurement. Additional shielding around the 
low-voltage terminals of the specimen connected to the measuring and guarded leads of 
the test set should help to minimize this problem; however, this solution is generally not 
practical in the field.
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3  
Types of Apparatus 

Transformers 
The voltage rating of each winding under test must be considered and the test voltage 
selected accordingly. If neutral bushings are involved, their voltage rating must be 
considered in selecting the test voltage. Measurements should be made between each 
interwinding combination (or set of three-phase windings in a three-phase transformer) 
with all other windings grounded to the tank (UST test). Measurements should also be 
made between each winding (or set of three-phase windings) and ground with all other 
windings guarded (GST test with guarding). In a two-winding transformer, a 
measurement should also be made between each winding and ground with the remaining 
winding grounded (GST GROUND test). For a three-winding transformer, a 
measurement should also be made between each winding and ground with one 
remaining winding guarded and the second remaining winding grounded (GST test with 
guarding). This special test is used to isolate the interwindings. A final measurement 
should be made between all windings connected together and the ground tank. It is also 
desirable to test samples of the liquid insulation. 

Figure 14 shows a typical setup for testing a two-winding transformer, Table 3 outlines 
the connections between the test set and two-winding transformer for each UST/GST 
test. Table 4 specifies the connections for three-winding transformers. Each winding 
should be shorted on itself at its bushing terminals. It is recommended that the 
Measurement Intercheck calculations, specified in Tables 3 and 4 be performed to 
validate all measurements. The calculated intercheck values should agree with the direct 
measurement values within reasonable limits. 

Table 5 shows typical setups for making transformer excitation current measurements.  

Increased dissipation factor values, in comparison with a previous test or tests on 
identical apparatus, may indicate some general condition such as contaminated oil. An 
increase in both dissipation factor and capacitance indicates that contamination is likely 
to be water. When the insulating liquid is being filtered or otherwise treated, repeated 
measurements on windings and the liquid will usually show whether good general 
conditions are being restored. 
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Oil oxidation and consequent sludging conditions have a marked effect on the 
dissipation factors of transformer windings. After such a condition has been remedied, 
(flushing down or other treatment) dissipation factor measurements are valuable in 
determining if the sludge removal has been effective. 

Measurements on individual windings may vary due to differences in insulation materials 
and arrangements. However, large differences may indicate localized deterioration or 
damage. Careful consideration of the measurements on different combinations of 
windings should show in which particular path the trouble lies; for example, if a 
measurement between two windings has a high dissipation factor, and the measurements 
between each winding and ground, with the remaining winding guarded, gives a normal 
reading, then the trouble lies between the windings, perhaps in an insulating cylinder. 

Bushings, if in poor condition, may have their losses masked by normal losses in the 
winding insulation. Therefore, separate tests should be applied to them. Temperature 
correcting curves for each design of transformer should be carefully established by 
measurement in factory or field and should be used to correct all measurements to a base 
temperature, usually 20°C. 

7 
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Figure 14: Two-Winding Transformer Tests 
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Table 3: Two-Winding Transformer Test Connections 
 

  Low Voltage Lead Configuration Test Connections To 
Windings 

 

Test 
No. 

Insulation 
Tested 

Test 
Mode 

Measures Grounds  
 
Guards 

 
Black 

 
 
Red

 
 
Blue 

 
 
Remarks 

 
1 

 
CHG+ CHL 

GST 
GND 

 Red & 
Blue 

  
H 

 
L 

 
⎯ 

 
L Grounded

 
2 

 
CHG 

 
GST 

  Red & 
Blue 

 
H 

 
L 

 
⎯ 

 
L Guarded 

 
3 

 
CHL 

 
UST 

 
Red 

 
Blue 

  
H 

 
L 

 
⎯ 

 

 
4 

 
CHL 

 
⎯ 

 
Test 1 minus Test 2 

 
⎯ 

 
⎯ 

 
⎯ 

Calculated 
intercheck 

 
5 

 
CLG + CHL 

GST 
GND 

 Red & 
Blue 

  
L 

 
H 

 
⎯ 

 
H Grounded

 
6 

 
CLG 

 
GST 

  Red & 
Blue 

 
L 

 
H 

 
⎯ 

 
H Guarded 

 
7 

 
CHL 

 
UST 

 
Red 

 
Blue 

  
L 

 
H 

 
⎯ 

 

 
8 

 
CHL 

 
⎯ 

 
Test 5 minus Test 6 

 
⎯ 

 
⎯ 

 
⎯ 

 
Calculated 
intercheck 

 
9 

         

 
10 

         

 
11 

         

 
12 

         

 
Equivalent Circuit 

 

 
Note: Short each winding on itself. 
 
Measurement Interchecks (Calculated) 
 
Capacitance Watts 
C4 = C1 - C2 W4 = W1 - W2 
 
C8 = C5 - C6 W8 = W5 - W6 

 
Note: Subscripts are test numbers 

H = High-voltage winding 
L = Low-voltage winding 
G = Ground 
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Table 4: Three-Winding Transformer Test Connections 
 

  Low Voltage Lead Configuration Test Connections 
To Windings  

Test 
No. 

Insulation 
Tested 

Test 
Mode Measures Grounds Guards  

Black 
Red Blue Remarks 

 
1 

 
CHG+ CHL 

 
GST 

  
Red 

 
Blue 

 
H 

 
L 

 
T 

L Grounded 
T Guarded 

 
2 

 
CHG 

 
GST 

  Red & 
Blue 

 
H 

 
L 

 
T 

 
L & T Guarded 

 
3 

 
CHL 

 
UST 

 
Red 

 
Blue 

  
H 

 
L 

 
T 

 
T Grounded 

 
4 

 
CHL 

 
⎯ 

 
Test 1 minus Test 2 

 
⎯ 

 
⎯ 

 
⎯ 

 
Calculated 
intercheck 

 
5 

 
CLG + CLT 

 
GST 

  
Red 

 
Blue 

 
L 

 
T 

 
H 

T Grounded 
H Guarded 

 
6 

 
CLG 

 
GST 

  Red & 
Blue 

 
L 

 
T 

 
H 

 
T & H Guarded 

 
7 

 
CLT 

 
UST 

 
Red 

 
Blue 

  
L 

 
T 

 
H 

 
H Grounded 

 
8 

 
CLT 

 
⎯ 

 
Test 5 minus Test 6 

 
⎯ 

 
⎯ 

 
⎯ 

 
Calculated 
intercheck 

 
9 

 
CTG + CHT 

 
GST 

  
Red 

 
Blue 

 
T 

 
H 

 
L 

H Grounded 
L Guarded 

 
10 

 
CTG 

 
GST 

  Red & 
Blue 

 
T 

 
H 

 
L 

 
H & L Guarded 

 
11 

 
CHT 

 
UST 

 
Red 

 
Blue 

  
T 

 
H 

 
L 

 
L Grounded 

 
12 

 
CHT 

 
⎯ 

 
Test 9 minus Test 10 

 
⎯ 

 
⎯ 

 
⎯ 

 
Calculated 
intercheck 

 
Equivalent Circuit 

 

Measurement Interchecks (Calculated) 
 
Capacitance Watts 
C4 = C1 - C2 W4 = W1 - W2 
 
C8 = C5 - C6 W8 = W5 - W6 
 
C12 = C9 - C10 W12 = W9 - W10 

 
Note: Subscripts are test numbers. 

H = High-voltage winding 
L = Low-voltage winding 
T = Tertiary winding 
G = Ground 
Note: Short each winding on itself. 
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Table 5: Transformer Excitation Current Test Connections 
 

Single Phase 
 

 

Measures Test Lead 
Connections 

 
Terminal 
Symbol 

 
Black 

 
 
Red 

 
 
Ground

H1-H2 
H2-H1 

H1 
H2 

H2 
H1 

⎯ 
⎯ 

Three Phase High Side “Y”  

 

 

Measures Test Lead 
Connections 

 
Terminal 
Symbol 

 
Black 

 
 
Red 

 
 
Ground

H1-H0 
H2-H0 
H3-H0 

H1 
H2 
H3 

H0 
H0 
H0 

⎯ 
⎯ 
⎯ 

Three Phase High Side “Δ“ 

 

 

Measures Test Lead 
Connections 

 
Terminal 
Symbol 

 
Black 

 
 
Red 

 
 
Ground

H1-H2 
H2-H3 
H3-H1 

H1 
H2 
H3 

H2 
H3 
H1 

H3 
H1 
H2 

 
 

DELTA - 3000 

DELTA - 3000 

DELTA - 3000 
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Circuit Breakers 
The most important insulation in medium and high-voltage outdoor power switch gear is 
that of the bushings themselves, the guide assembly, the lift rods, and, in the case of oil 
circuit breakers, the oil. Measurements should be made from each bushing terminal to 
the ground tank with the breaker open, and from each phase (each pair of phase bushing 
terminals) to the grounded tank with the breaker closed. When an individual bushing 
assembly is tested in each phase, the other bushing terminal in that phase should be 
guarded. It is also desirable to test samples of the liquid insulation. 

The specific term “tank-loss index” has been developed to assist in evaluating the results 
of the open and closed oil circuit breaker tests. It is defined for each phase as the 
difference of the measured open circuit and closed circuit power, in watts. To obtain the 
open circuit value, the individual values measured on the two bushings of each phase 
must be summed. Tank-loss index may have values ranging from positive to negative 
which will give an indication of the possible source of a problem. Positive indexes occur 
when the closed circuit values are larger than the sum of the open circuit values. 
Conversely, negative indexes occur when the closed circuit values are smaller than the 
sum of the open circuit values. The test results should be recorded in terms of equivalent 
10 kV watts or 2.5 kV watts/milliwatts regardless of the test voltage used. To obtain 
watts from a previous measurement of capacitance and dissipation factor, refer to the 
conversion formulas. 

The Oil Circuit Breakers test data form in Appendix C outlines the specific connections 
between the test set and breaker as well as the series of measurements which should be 
performed on the breaker. 

Table 6, SF6 Dead Tank Circuit Breaker Test Connections, outlines the specific 
connections between the test set and breaker as well as the series of measurements that 
should be performed on the breaker. 

Comparison of tank-loss indexes taken when an oil circuit breaker is new and initially 
installed will give the general range of values to expect from a good unit. This practice 
also will avoid condemning a good unit as the result of the inherent design of a particular 
manufacturer that normally may show tank-loss indexes without the unit being defective 
or deteriorated. 

The losses in an oil circuit breaker are different between an open circuit test and a closed 
circuit test because the voltage stress on the insulating members is distributed differently. 
Tables 7 and 8 summarize what may be defective based upon the polarity of the tank-
loss index. Once a particular section has given indications of deterioration, the test 
results should be verified by systematically isolating the suspected insulating member 
before disassembling the unit. 

Oil circuit breakers are composed of many different materials each having its own 
temperature coefficient. For this reason it may be difficult to correct tank-loss indexes 
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for a standard temperature. On this basis, an attempt should be made to conduct tests at 
approximately the same time of the year to minimize temperature variations. The 
measurements on the bushings, however, may readily be corrected to the base 
temperature, usually 20°C. Separate tests for measuring the losses in the bushings are 
described later. 

Air and gas circuit breakers vary so much in construction that specific instructions and 
interpretation would be too lengthy. This section, however, does contain a detailed test 
connection chart (Table 9) outlining the normal series of measurements performed on a 
General Electric Type ATB Air-Blast Circuit Breaker. Table 10 outlines the normal series 
of measurements performed on a three-column live tank breaker. 
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Table 6: SF6 Dead Tank Circuit Breaker Test Connections 
 

    
Low Voltage Lead Configuration 

Test Connections To 
Bushings 

 

 
Test 
No. 

 
 

CB 

 
Insulation 

Tested 

 
Test 

Mode 

 
 

Measures

 
 

Grounds 

 
 

Guards
 

Black 

 
 

Red 

 
 

Blue 

 
 

Remarks 
 
1 

  
C1G 

GST 
GND 

 Red & 
Blue 

  
1 

   
Bushing 2 floating 

 
2 

 
 

 
C2G 

GST 
GND 

 Red & 
Blue 

  
2 

   
Bushing 1 floating 

 
3 

 
O 

 
C3G 

GST 
GND 

 Red & 
Blue 

  
3 

   
Bushing 4 floating 

 
4 

P 
E 

 
C4G 

GST 
GND 

 Red & 
Blue 

  
4 

   
Bushing 3 floating 

 
5 

N  
C5G 

GST 
GND 

 Red & 
Blue 

  
5 

   
Bushing 6 floating 

 
6 

  
C6G 

GST 
GND 

 Red & 
Blue 

  
6 

   
Bushing 5 floating 

 
7 

 
O 

 
C12 

 
UST 

 
Red 

 
Blue 

  
1 

 
2 

  

 
8 

P 
E 

 
C34 

 
UST 

 
Red 

 
Blue 

  
3 

 
4 

  

 
9 

N  
C56 

 
UST 

 
Red 

 
Blue 

  
5 

 
6 

  

 
10 

C 
L 

 
C1G + C2G 

GST 
GND 

 Red & 
Blue 

  
1 or 2 

   

 
11 

O 
S 

 
C3G + C4G 

GST 
GND 

 Red & 
Blue 

  
3 or 4 

   

 
12 

E 
D 

 
C5G + C6G 

GST 
GND 

 Red & 
Blue 

  
5 or 6 

   

 
Diagram 
 

 

 

Insulation Tested 
1 to 6 = Bushing terminals 
G = Ground 
 
Note: No. in Black  column is bushing 
energized. Tests 1 through 6, 10, 11, and 12 
all other bushings must be floating. 

 

 



 

 
AVTM673001 Rev F Sept 2008 

102 

.Table 7: Tank-Loss Index of Oil Circuit Breakers (Equivalent to 10 kV Losses) 

Tank Loss 

Index 

 

Test Remarks 

 

Probable Problem 

Insulation 
Rating 

<±0.16 W Normal results for both 
open CB tests 

None Good 

>+0.16 W Normal results for both 
open CB tests 

1. Tank oil 

2. Tank liner 

3. Lift rod 

4. Auxiliary contact insulation 

Investigate 

>-0.16 W High losses for both open 
CB tests  

 

Closed CB test near normal

1. Cross guide assembly 

2. Isolated cross guide 

3. Contact assembly insulation 

4. Lift rod upper section 
(moisture contaminated) 

Investigate 

<±0.16 W Normal results for one 
open CB test 

  

Other has high losses 

1. Bushing with high loss 
reading 

2. Arc interruption assembly 

Investigate 

<±0.16 W High losses for both open 
CB tests and closed CB test

1. Bushings 

2. Arc interruption assembly 

3. Tank oil 

4. Tank liner 

5. Lift rod 

6. Auxiliary contact insulation 

7. Cross guide assembly 

8. Isolated cross guide 

9. Contact assembly insulation 

Investigate 
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Table 8: Tank-Loss Index of Oil Circuit Breakers (Equivalent to 2.5 kV Losses) 

Tank Loss 

Index 
Test Remarks Probable Problem Insulation 

Rating 

<±10 mW Normal results for both 
open CB tests 

None Good 

>+10 mW Normal results for both 
open CB tests 

1. Tank oil 

2. Tank liner 

3. Lift rod 

4. Auxiliary contact insulation 

Investigate 

>-10 mW High losses for both open 
CB tests  

 

Closed CB test near normal

1. Cross guide assembly 

2. Isolated cross guide 

3. Contact assembly insulation 

4. Lift rod upper section 
(moisture contaminated) 

Investigate 

<±10 mW Normal results for one 
open CB test 

  

Other has high losses 

1. Bushing with high loss 
reading 

2. Arc interruption assembly 

Investigate 

<±10 mW High losses for both open 
CB tests and closed CB test

1. Bushings 

2. Arc interruption assembly 

3. Tank oil 

4. Tank liner 

5. Lift rod 

6. Auxiliary contact insulation 

7. Cross guide assembly 

8. Isolated cross guide 

9. Contact assembly insulation 

Investigate 
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Table 9: General Electric Air-Blast Type Circuit Breaker Test Connections 
 

   
Low Voltage Lead Configuration 

Test Connections 
To Breaker 

 

 
Test 
No. 

 
 

Insulation Tested 

 
Test 

Mode 

 
 

Measures 

 
 

Grounds

 
 

Guards
 

Black 

 
 

Red 

 
 

Blue 

 
 

Remarks 
 
1 

 
C2 + B2 

 
UST 

 
Red 

 
Blue 

  
D 

 
F 

 
A 

 
A Grounded

 
2 

 
C1 + B1 + I1 

 
UST 

 
Blue 

 
Red 

  
D 

 
F 

 
A 

 
F Grounded

 
3 

 
C2 + B2 + C1 + B1 

+ I1 

 
UST 

Red & 
Blue 

   
D 

 
F 

 
A 

 

 
4 

 
R (or R + I3) 

 
GST 

  Red 
& 

Blue

 
D 

 
F 

 
A 

 
F & A 

Guarded 
 
5 

 
I2 + T * 

 
GST 

 Red  
Blue

 
A 

 
F 

 
D 

D Guarded 
F Grounded

 
 

         

 
*Test performed only on units with current transformer. 
 

Measurement Intercheck 
 
Capacitance:
Watts: 

C1 = C3 - C2 
W1 = W3 - W2 

Note: Subscripts are test no.’s. 
 

B1  & B2 Entrance bushings  
C1  & C2 Grading capacitors  
D Module live tank  
I1 Upper insulator  
I2 Lower insulator  
I3 Insulator for units without current transformer  
R Glass fiber air supply tube, open rods and 

wood tie rods 
 

T Current transformer insulation  
I4 and I5 Protective glass fiber tube that encloses R tube 

is slit at “E” with metal guard ring 
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Table 10: Live Tank Circuit Breaker Test Connections (Typical Three-Column Support Per Phase) 
 

    
Low Voltage Lead Configuration 

Test Connections 
To Breaker 

 

 
Test 
No. 

 
Insulation 

Tested 

 
 
φ 

 
Test 

Mode 

 
 

Measures 

 
 

Grounds 

 
 

Guards 
 

Black 

 
 

Red

 
 

Blue 

 
 

Remarks 
 
1 

 
C1 

  
UST 

 
Red 

 
Blue 

  
B 

 
A 

 
C 

 
C Grounded 

 
2 

 
C2 

  
UST 

 
Blue 

 
Red 

  
B 

 
A 

 
C 

 
A Grounded 

 
3 

 
S1 

  
GST 

  Red & 
Blue 

 
B 

 
A 

 
C 

 
A & C Guarded 

 
4 

 
C3 

  
UST 

 
Red 

 
Blue 

  
D 

 
C 

 
E 

 
E Grounded 

 
5 

 
C4 

  
UST 

 
Blue 

 
Red 

  
D 

 
C 

 
E 

 
C Grounded 

 
6 

 
S2 

  
GST 

  Red & 
Blue 

 
D 

 
C 

 
E 

 
C & E Guarded 

 
7 

 
C5 

  
UST 

 
Red 

 
Blue 

  
F 

 
E 

 
G 

 
G Grounded 

 
8 

 
C6 

  
UST 

 
Blue 

 
Red 

  
F 

 
E 

 
G 

 
E Grounded 

 
9 

 
S3 

  
GST 

  Red & 
Blue 

 
F 

 
E 

 
G 

 
E & G Guarded 

 
10 

          

 
11 

          

 
12 

          

 
Diagram 

 

Note: To reduce the effects of severe electrostatic 
interference, disconnect one side of L1 and L2 links to 
break circuit between modules. All terminals and bus 
work not in measurement circuit must be solidly 
grounded. 

A, C, E & 
G  

Low lead test connections  

B, D, F Module live tanks  

C1 thru C6 Module entrance bushing and grading 
capacitors 

 

L1, L2 Connection links joining modules  

S1, S2, S3 Module support columns  
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Bushings 
All modern bushings rated 23 kV and higher have a power factor or a capacitance tap 
which permits dissipation factor testing of the bushing while it is in place on the 
apparatus without disconnecting any leads to the bushing. The dissipation factor is 
measured by the ungrounded specimen test (UST) which eliminates the influence of 
transformer winding insulation, breaker arc-interrupters, or support structures which are 
connected to the bushing terminal. The effects of stray capacitance between the bushing 
terminal and ground as well as surface leakage over the porcelain are also eliminated 
from the measurement. The UST method measures only the bushing and is not 
appreciably affected by conditions external to the bushing. 

Figure 15 shows the test connections between the test set and bushing when using the 
UST test mode. Connect the high-voltage lead (black boot) to the terminal at the top of 
the bushing and the low-voltage lead (red boot) to the power factor tap. Ground the 
apparatus tank. The tap is normally grounded through a spring and it is necessary, when 
making measurements, to remove the plug which seals and grounds the tap. Use the 
UST measure red, ground blue test mode setting. 

The UST test also can be used for making measurements on bushings which have 
provisions for flange isolation. The normal method of isolating the flange from the 
apparatus cover is to use insulating gaskets between the flange and cover and insulating 
bushings on all but one of the bolts securing the mounting flange to the cover. During 
normal operation, the flange is grounded by a single metal bolt; however, when testing 
the bushing, this bolt is removed. The measurement is identical to that when testing 
bushings which have a power factor tap except that the low-voltage lead, red in this case, 
is connected to the isolated bushing flange. 

Hot Collar Test 

The dielectric losses through the various sections of any bushing or pothead can be 
investigated by means of a hot collar test which generates localized high-voltage stresses. 
This is accomplished by using a conductive hot collar band designed to fit closely to the 
porcelain surface, usually directly under the top petticoat, and applying a high voltage to 
the band. The center conductor of the bushing is grounded. This test provides a 
measurement of the losses in the section directly beneath the collar and is especially 
effective in detecting conditions such as voids in compound filled bushings or moisture 
penetration since the insulation can be subjected to a higher voltage gradient than can be 
obtained with the normal bushing tests.  
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Measures main bushing insulation C1 

 
CHG, CHL, and C3 shunt power supply, therefore no influence on measurement 
 
C2 shunts bridge winding, therefore negligible influence if less than 5000 pF 

Figure 15: UST Test on Transformer Bushing 

DELTA - 3000 
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This method is also useful in detecting faults within condenser layers in condenser-type 
bushings and in checking the oil level of oil-filled bushings after a pattern of readings for 
a normal bushing has been established. If an abnormal capacitance or dissipation factor 
reading is obtained, the test should be repeated with the hot collar band wrapped around 
the porcelain surface directly under the second petticoat rather than the first. If 
necessary, move the band further down on the bushing to determine the depth that the 
fault has progressed. The hot collar measurements are made by normal GST GROUND 
test method and the bushing need not be disconnected from other components or 
circuits. Make sure that the collar band is drawn tightly around the porcelain bushing to 
ensure a good contact and eliminate possible partial discharge problems at the interface. 
Refer to the sections on “Significance of Humidity” and “Surface Leakage” if tests are 
made under unfavorable weather conditions. 

Power Factor or Capacitance Tap Test 

Insulation tests on a power factor or capacitance tap of a bushing are performed by the 
GST with low lead guarded test method. For this test the high-voltage lead is connected 
to the tap, the low-voltage red lead to the bushing center conductor, and the bushing 
flange grounded. This method measures only the insulation between the tap and ground 
and is not appreciably affected by connections to the bushing center conductor. 

G 
CAUTION 

The power factor tap is normally designed to 
withstand only about 500 V while a capacitance tap 
may have a normal rating of 2.5 to 5 kV. Before 
applying a test voltage to the tap, the maximum safe 
test voltage must be known and observed. An 
excessive voltage may puncture the insulation and 
render the tap useless. 

Some bushings do not have a power factor or capacitance tap or an isolated mounting 
flange. These bushings must be electrically isolated from the apparatus for test. This can 
be accomplished by removing the metal bolts and temporarily replacing them with 
insulated bolts. The insulating gasket between the bushing flange and apparatus cover 
will normally provide sufficient insulation so that a UST type measurement can be made 
on the bushing in the same manner as for a bushing which has provisions for flange 
isolation. Verify isolation with an ohmmeter. 

Evaluation of Test Results 
Interpretation of capacitance and dissipation factor measurements on a bushing requires 
a knowledge of the bushing construction since each type bushing has its own peculiar 
characteristics. For example, an increase in dissipation factor in an oil-filled bushing may 
indicate that the oil is contaminated, whereas an increase in both dissipation factor and 
capacitance indicates that the contamination is likely to be water. For a condenser type 
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bushing which has shorted layers, the capacitance value will increase, whereas the 
dissipation factor value may be the same in comparison with previous tests. 

Except for the specific purpose of investigating surface leakage, the exposed insulation 
surface of the bushing should be clean and dry to prevent surface leakage from 
influencing the measurement. The effects of surface leakage are eliminated from the 
measurement when testing by the UST test method. 

Temperature correction curves for each design of bushing should be carefully 
established by measurement and all measurements should be temperature corrected to a 
base temperature, usually 20°C. The temperature measurement should be based on that 
at the bushing surface. The air temperature should also be recorded. When testing a 
bushing by the grounded specimen method, the surface of the bushing should be at a 
temperature above the dew point to avoid moisture condensation. 

Rotating Machines 
The main purpose of capacitance and dissipation factor tests on rotating machines is to 
assess the extent of void formation within the winding insulation and the resulting 
damage to the insulation structure due to ionization (partial discharge) in the voids. An 
overall measurement on a winding will also give an indication of the inherent dissipation 
factor of the winding insulation and will reveal potential problems due to deterioration, 
contamination, or moisture penetration. 

A power factor (dissipation factor) tip-up test is a widely used maintenance test in 
evaluating the extent of insulation deterioration caused by ionization. In this test, the 
dissipation factor is measured at two different voltages, the first low enough so that no 
ionization occurs (normally 25 percent of rated line-to-ground voltage), the second at 
rated line to ground voltage or slightly above rated voltage. The tip-up value is obtained 
by subtracting the value of the dissipation factor measured at the lower test voltage from 
that measured at the higher test voltage. When the dissipation factor increases 
significantly above a certain voltage, it is evident that ionization is active and producing 
some loss. An increase in dissipation factor above a certain voltage is a guide to the rate 
at which ionization is occurring and gives guidance as to how the ionization action may 
be expected to accelerate. If voids are short-circuited when ionization occurs, some 
increase of capacitance with voltage may also result. Any forecast of remaining useful life 
must be based upon knowledge of the resistance of the particular insulation to 
ionization. 

In general, the coils nearest the line terminals and operating at the highest voltage to 
ground are most affected by ionization. The reliable life remaining in a winding can often 
be extended by obtaining dissipation factor versus voltage curves on all coils, replacing 
only the worst, and regrouping them so that the coils with the least increase of 
dissipation factor, and preferably lower value of dissipation factor, are nearest the line 
terminals. Considerable extension of winding life can also be realized in many cases by 
measuring dissipation factor versus voltage on groups of coils without removal and 
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rearranging the line and neutral connections accordingly. This can be done several times 
in a lifetime so that the coils are evenly deteriorated. 

An overall measurement on a rotor or stator winding is made on the insulation between 
the winding and ground. In the case of three-phase stator windings, where the 
connection between the winding phases and neutral can be conveniently opened, 
additional measurements are also made on the interwinding or phase-to-phase insulation. 
When a tip-up test is made on a complete phase winding, only the average value is 
measured; an isolated section having an abnormally high tip-up may be completely 
masked. 

Table 11 shows the specific connections between the test set and a typical generator 
three-phase stator winding as well as the routine series of measurements performed on 
the windings. It is assumed that the connection between the winding phases and also 
neutral are opened. The phase-to-ground insulation tests are made by the GST test 
method, whereas, the phase-to-phase tests are made by the UST test method. 

When testing large generator windings which have a very high value of capacitance per 
phase, the maximum specimen capacitance measurable at a particular test voltage may be 
limited due to the thermal rating of the power supply transformer (refer to Section 3, 
Specifications). For this case tests will have to be made at a reduced voltage level or with 
the use of Resonating Inductor (Cat. No. 670600). 

The temperature of the windings should be above and never below the ambient 
temperature to avoid the effects of moisture condensation on the exposed insulating 
surface. Temperature measurements when using temperature correction curves should 
be based on that at the winding surface. 

Avoid prolonged exposure to high humidity conditions before testing because such 
exposure may result in moisture absorption in the insulating materials. It is desirable to 
make tests on the winding insulation shortly after shutdown. 
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Table 11: Three-Phase Rotating Machinery Stator Test Connections (Motors and Generators) 

   
Low Voltage Lead Configuration

Test Connections 
To Windings 

 

 
Test 
No. 

 
 

Insulation Tested 

 
Test 

Mode 

 
 

Measures

 
 

Ground
s 

 
 

Guards
 

Black 

 
 

Red 

 
 

Blue 

 
 

Remarks 

 
1 

 
A to  

 
GST 

  Red & 
Blue 

 
A 

 
B 

 
C 

 
B & C Guarded 

 
2 

 
A to B 

 
UST 

 
Red 

 
Blue 

  
A 

 
B 

 
C 

 
C Grounded 

 
3 

 
B to  

 
GST 

  Red & 
Blue 

 
B 

 
C 

 
A 

 
C & A Guarded 

 
4 

 
B to C 

 
UST 

 
Red 

 
Blue 

  
B 

 
C 

 
A 

 
A Grounded 

 
5 

 
C to  

 
GST 

  Red & 
Blue 

 
C 

 
A 

 
B 

 
A & B Guarded 

 
6 

 
C to A 

 
UST 

 
Red 

 
Blue 

  
C 

 
A 

 
B 

 
B Grounded 

 
7 

 
A + B + C to  

GST 
GN
D 

    
A,B,

C 

 
⎯ 

 
⎯ 

May require 
Resonating 
Inductor 

 
 

 
 

 
 

    
 

 
 

 
 

 
 

 
 

         

 
 

         

 
Equivalent Circuit    Remarks 

 
A = Phase A winding 
B = Phase B winding 
C = Phase C winding 
G = Ground 
Note: Short each winding on itself if possible. 
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Cables 
Cables rated for operation at 5 kV and above are usually shielded by a metal cable 
sheath. Measurements for this type cable are made by the GST GROUND test method 
and are confined to the insulation between the conductor and the sheath. The high-
voltage lead is connected to the cable conductor and the cable sheath solidly connected 
to the same grounding system as the test set. 

When testing three conductor cables which have a single metal cable sheath, UST tests 
should be made between each conductor combination with the remaining cable 
grounded. A second set of tests should be made between each conductor and ground 
with the remaining two conductors guarded (GST test with guarding). A third test 
should be made between all conductors connected together and ground (GST 
GROUND test). This test procedure is similar to that when testing three winding 
transformers. 

The test set measures the average dissipation factor of the cable; therefore, if a long 
length of cable is measured, an isolated section of cable having an abnormally high 
dissipation factor may be completely masked and have no significant effect on the 
average value. Thus, the ability to detect localized defects will diminish as the cable 
length increases. Tests on long lengths of cable give a good indication of the inherent 
dissipation factor of the insulation and when compared with previous tests or 
measurements on similar cable may reveal potential problems due to general 
deterioration, contamination, or moisture penetration. 

Cables are inherently of relatively high capacitances per unit length (typically 0.5 μF per 
phase per mile) so that for long lengths the kVA capacity of the test set power supply 
may be exceeded. Refer to Section 3, Specifications, for maximum specimen capacitance 
measurable at a particular test voltage. 

Surge (Lightning) Arresters 
A complete test on a surge arrester involves impulse and overvoltage testing as well as a 
test for power loss at a specified test voltage using normal 50/60 Hz operating 
frequency. Impulse and overvoltage testing is not generally performed in the field since it 
involves a large amount of test equipment that is not easily transportable. Experience has 
demonstrated that the measurement of power loss is an effective method of evaluating 
the integrity of an arrester and isolating potential failure hazards. This test reveals 
conditions which could affect the protective functions of the arrester, such as: the 
presence of moisture, salt deposits, corrosion, cracked porcelain, open shunt resistors, 
defective pre-ionizing elements, and defective gaps. 

To evaluate the insulation integrity of an arrester, measure the power loss (watts-loss or 
dissipation factor) at a specified voltage and compare it with previous measurements on 
the same or similar arrester. Measurements on a surge arrester should always be 
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performed at the same or recommended test voltage since nonlinear elements may be 
built into an arrester. When using this test set, all measurements should normally be 
made at 10 kV. Except for the specific purpose of investigating surface leakage, the 
exposed insulation surface of an arrester should be clean and dry to prevent leakage from 
influencing the measurements. 

Some types of arresters show a substantial temperature dependence, while others show 
very little dependence. Temperature correction curves for each arrester design should be 
carefully established by measurement, and all measurements should be temperature 
corrected to a base temperature, usually 20°C. The temperature measurement should be 
based on that at the arrester surface. The air temperature should also be recorded. The 
surface of the arrester should be at a temperature above the dew point to avoid moisture 
condensation. 

F 
WARNING 

Exercise extreme care when handling arresters 
suspected of being damaged, since dangerously high 
gas pressures can build up within a sealed unit. 

It is recommended that tests be made on individual arrester units rather than on a 
complete multi-unit arrester stack. A single arrester unit can be tested by the normal 
ungrounded specimen test (UST) in the shop; however, it can only be tested by the 
grounded specimen test (GST) when mounted on a support structure in the field. Table 
11 shows the recommended test procedure for testing installed multi-unit arrester stacks. 
When testing in the field, disconnect the related high-voltage bus from the arrester. 

Surge arresters are often rated on the basis of watts loss. To obtain the equivalent 10 kV 
watts loss from a measurement of capacitance and dissipation factor, perform the 
following calculations: 

Watts loss = CpF x %DF x 377 x 10-6 (for 60 Hz) 

Watts loss = CpF x %DF x 314 x 10-6 (for 50 Hz) 

where:  CpF =  capacitance in picofarads 

 %DF =  percent dissipation factor 

Note: Capacitance, dissipation factor, power factor, watts at 10 kV, current, and 
current at 10 kV can all be read directly from the DELTA-3000 test set. 
These formulas are provided for informational purposes only. 
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Table 12: Surge Arrester Test Connections 
 

   
Low Voltage Lead Configuration

Test Connections 
To Surge Arrester 

 

 
Test 
No. 

 
Surge Arrester Symbol 

Insulation Tested 

 
Test 

Mode 

 
 

Measures 

 
 

Ground
s 

 
 

Guards
 

Black 

 
 

Red 

 
 

Blue 

 
 

Remarks 

 
1 

 
SA -A 

 
UST 

 
Blue 

 
Red 

  
2 

 
3 

 
1 

 
Terminal 3 
Grounded 

 
2 

 
SA - B 

 
UST 

 
Red 

 
Blue 

  
2 

 
3 

 
1 

 
Terminal 1 
Grounded 

 
3 

 
SA - C 

 
UST 

 
Red 

 
Blue 

  
4 

 
3 

 
⎯ 

 

 
4 

 
SA - D 

 
GST 

   
Red 

 
4 

 
3 

 
⎯ 

 
Terminal 3 Guarded 

 
Note: All tests normally made at 10 kV. 
 

 

Typical Multi-Unit Arrester Stack 
 



Appendix B 
Applications Guide  

 

 
AVTM673001 Rev F Sept 2008 

115 

In some cases, where limited test data are recorded, it may be desirable to convert 
equivalent 10 kV watts loss to equivalent 2.5 kV watts loss and vice versa. The 
conversion can be made using the following formula. Keep in mind that the relationship 
is true only when testing arresters which have a linear response below a 10 kV test 
voltage. 

Watts loss kV Watts loss kV@ . @2 5 10
16

=  

An increase in dissipation factor or watts loss values compared with a previous test or 
tests on identical arresters under the same conditions may indicate: 

 Contamination by moisture 

 Contamination by salt deposits 

 Cracked porcelain housing 

 Corroded gaps. 

A decrease in dissipation factor or watts loss values may indicate: 

 Open shunt resistors 

 Defective pre-ionizing elements. 

Liquids 
To measure the dissipation factor of insulating liquids, a special test cell such as the 
Biddle Catalog No. 670511 Oil Test Cell is required. It is constructed with electrodes 
which form the plates of a capacitor and the liquid constitutes the dielectric. The test cell 
is a three-terminal type with a guard electrode to avoid measuring fringe effects and the 
insulation for the electrode supports. 

When samples of insulating liquid are tested, the specimen capacitance is used for 
determining the dielectric constant (permittivity) of the insulating liquid. The ratio of the 
test cell capacitance measured when empty (air dielectric) to the test cell capacitance 
measured when filled (liquid dielectric) is the value of dielectric constant of the liquid. 
Instructions for the use of the Oil Test Cell are contained in Instruction Manual 
AVTM670511. 

Miscellaneous Assemblies and Components 
When an apparatus is dismantled to locate internal trouble and make repairs, dissipation 
factor measurements can be valuable in detecting damaged areas of insulation to such 
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parts as wood or fiberglass lift-rods, guides or support members. Sometimes existing 
metal parts can be used as the electrodes between which measurements can be made. 
Sometimes it will be necessary to provide electrodes. Conductive collars, can be used; 
aluminum foil also works well. Whenever conducting material is used, ensure that 
intimate contact is made with the critical areas of the insulation. Petroleum jelly or Dow 
Corning #4 insulating grease applied at the interface surface often helps to obtain better 
physical contact. 

It may sometimes be necessary to separate volume losses from surface losses by 
providing a third (guard) terminal on or within the specimen insulation system. For 
example, an insulating tube formed over a metal rod may be tested for internal damage 
in the insulation. A conductive band (or foil) is applied near the center of the insulating 
tube with additional conductive (guard) bands on each side, separated from the center 
band by enough clean insulation to withstand the intended test voltage. With the metal 
rod grounded, the test set will measure the capacitance and dissipation factor of the 
volume of insulation between the center conductive band (high-voltage) and the metal 
rod. Figure 16 shows a typical test setup. 

Comparisons between dissipation factors of suspected areas and components against 
similar parts which can be assumed to be in good condition are of prime importance in 
analyzing insulation components. Dissipation factor voltage measurements can indicate 
the presence of ionization in a component by a sudden tip-up of dissipation factor as the 
test voltage is increased. Delaminations within a material can also be detected in this way. 
Avoid overstressing component insulation by indiscriminate use of the available test 
voltage. Consider the voltage on the component under normal operating conditions. 

 

Figure 16: GST Test with Guarding on Insulated Tube Covering Metal Rod 
 



 

 
AVTM673001 Rev F Sept 2008 

117 

 
 
 
 
 
 
 
 
 
 
 
 

Appendix C 
Test Data Forms 

 
 
 
 



M 
 

 

 
AVTM673001 Rev F Sept 2008 

118 

 

 

 

 

 

 

 

 

 

 

 

 

M 

 



Appendix C 
Test Data Forms 

 
AVTM673001 Rev F Sept 2008 

119 

Test Data Forms 
 Two-Winding Transformers Capacitance and Power Factor Tests 

 Three-Winding Transformers Capacitance and Power Factor Tests 

 Transformer Excitation Current Tests 

 Oil Circuit Breakers Capacitance and Power Factor Tests 

 SF6 Dead Tank Circuit Breakers Capacitance and Power Factor Tests 

 Vacuum Circuit Breakers Capacitance and Power Factor Tests 

 Air-Magnetic Circuit Breakers Capacitance and Power Factor Tests 

 Rotating Machinery (Motors and Generators) Capacitance and Power Factor Tests 

 Miscellaneous Equipment Capacitance and Power Factor Tests 

 

 



M 
 

 

 
AVTM673001 Rev F Sept 2008 

120 

 

 

 

 

 

 

 

 

 

 

 

 

M 

 

 



 

 
AVTM673001 Rev F Sept 2008 

121 

 

Megger 
Norristown, PA U.S.A. 

Two-Winding Transformers 
Capacitance and Power Factor Tests 

 
COMPANY DATE 
TEST LOCATION TESTED BY 
XFMR IDENT. TEST SET NO. 
XFMR SERIAL NO. AIR TEMPERATURE 
XFMR MFR                                         TYPE                                  KVA OIL TEMPERATURE 
HIGH KV                                             SGL     Y     Δ  % RH 
HIGH KV BUSH WEATHER 
LOW KV                                             SGL     Y     Δ  TERTIARY KV                                               SGL     Y     Δ  
LOW KV BUSH TERTIARY BUSH 

 
TRANSFORMER OVERALL TESTS 

   TEST CONNECTIONS 
(WINDINGS) 

  % POWER FACTOR  EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
INSULATION TESTED 

TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE  
C (PF) 

 
MEASURED 

20°C 
%PF 

CORR 
FCTR 

 
mA 

 
WATTS 

ATION 
RATING 

1 CHG + CHL GST 
GND 

H L           

2 CHG GST H  L          
3 CHL UST H   L         
4 CHL ⎯ TEST 1 MINUS TEST 2 ⎯        
5 CLG  + CHL GST 

GND 
L H           

6 CLG GST L  H          
7 CHL UST L   H         
8 CHL ⎯ TEST 5 MINUS TEST 6 ⎯        
9 CHG’ ⎯ CHG MINUS HIGH 

BUSH. 
⎯        

10 CLG’ ⎯ CLG MINUS LOW 
 BUSH. 

⎯        

 
BUSHING TESTS 

TEST 
NO. 

BUSHING 
NO. SER. NO. 

φ              

 11 
 

   UST             

HI 
kV 

12    UST             

 
 

13    UST             

 
 

14 N   UST             

 
 

15    UST             

LO 
kV 

16    UST             

 
 

17    UST             

 
 

18 N   UST             

 
 

19 OIL TEST  UST             

 
INSULATION RATING KEY   EQUIVALENT CIRCUIT   REMARKS 
          Test No. 4, 8, 9, 10 are calculated intercheck 
values. 
G =  GOOD 
D = DETERIORATED 
I =  INVESTIGATE 
B = BAD (REMOVE OR RECONDITION) 
 
 
H =  HIGH -VOLTAGE WINDING 
L =  LOW-VOLTAGE WINDING 
G =  GROUND 
N = NEUTRAL BUSHING 
NOTE: SHORT EACH WINDING ON ITSELF.  
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Megger 
Norristown, PA U.S.A. 

Three-Winding Transformers 
Capacitance and Power Factor Tests 

COMPANY DATE 
TEST LOCATION TESTED BY 
XFMR IDENT. TEST SET NO. 
XFMR SERIAL NO. AIR TEMPERATURE 
XFMR MFR                                         TYPE                                  KVA OIL TEMPERATURE 
HIGH KV                                             SGL     Y     Δ  % RH 
HIGH KV BUSH WEATHER 
LOW KV                                             SGL     Y     Δ  TERTIARY KV                                               SGL     Y     Δ  
LOW KV BUSH TERTIARY BUSH 

TRANSFORMER OVERALL TESTS 
   TEST CONNECTIONS  

(WINDINGS)    
% POWER FACTOR 

 EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
INSULATION TESTED 

TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE C 
(PF) 

 
MEASURED 

20°C 
%PF 

CORR 
FCTR 

 
mA 

 
WATTS 

LATION 
RATING 

1 CHG + CHL GST H L T          
2 CHG GST H  L&T          
3 CHL UST H T  L         
4 CHL ⎯ TEST 1 minus TEST 2         
5 CLG  + CLT GST L T H          
6 CLG GST L  T&H          
7 CLT UST L H  T         
8 CLT ⎯ TEST 5 minus TEST 6         
9 CTG + CHT GST T H L          

10 CTG GST T  H&L          
11 CHT UST T L  H         
12 CHT ⎯ TEST 9 minus TEST 10         
13 CHG’ ⎯ CHG  minus high bushings         
14 CLG’ ⎯ CLG minus low bushings         
15 CTG’ ⎯ CTG minus tertiary bushings.         

BUSHING TESTS 

TEST NO. BUSHING 
NO.   SER. NO. φ              

 
 16    UST             

HI 
kV 17    UST             

 
 18    UST             

 
 19 N   UST             

 
 20    UST             

LO 
kV 21    UST             

 
 22    UST             

 
 23 N   UST             

 
 24    UST             

 
T 25    UST             

kV 
 26    UST             

 
 27 N   UST             

 
 28 OIL TEST UST             

 
INSULATION RATING KEY   EQUIVALENT CIRCUIT  REMARKS 
G =  GOOD        Test No. 4, 8, 12, 13, 14, 15 are calculated intercheck values 
D = DETERIORATED 
I =  INVESTIGATE 
B = BAD (REMOVE OR RECONDITION) 
 
H =  HIGH -VOLTAGE WINDING 
L =  LOW-VOLTAGE WINDING 
T = TERTIARY WINDING 
G =  GROUND 
N =    NEUTRAL BUSHING 
NOTE: SHORT EACH WINDING ON ITSELF. 
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Megger 
Norristown, PA U.S.A. 

Transformer 
Excitation Current Tests 

 
COMPANY DATE 
TEST LOCATION TESTED BY 
XFMR INDENT. TEST SET NO. 
XFMR SERIAL NO. AIR TEMPERATURE 
XFMR MFR                     TYPE                       KVA OIL TEMPERATURE 
HIGH KV                          SGL     Y     Δ  %RH 
LOW KV                           SGL     Y     Δ  WEATHER 
TERTIARY KV                  SGL     Y     Δ   
 

 Δ  PHASE A PHASE B PHASE C  

TEST 
NO. 

 LOAD TAP 
CHANGER 
POSITION 

TEST 
KV 

TERMINAL 
SYMBOL 

MILLI- 
AMPERES

TERMINAL 
SYMBOL 

MILLI- 
AMPERES 

TERMINAL 
SYMBOL 

MILLI- 
AMPERES REMARKS 

1 
 

         

2 
 

         

3 
 

         

4 
 

         

5 
 

         

6 
 

         

7 
 

         

8 
 

         

9 
 

         

10 
 

         

11 
 

         

12 
 

         

13 
 

         

14 
 

         

15 
 

         

16 
 

         

17 
 

         

18 
 

         

19 
 

         

20 
 

         

 
Δ TAP POSITION         REMARKS 
R = RAISED 
L = LOWERED 
N = NEUTRAL 
NOTE: Periodic tests should be performed at same test voltage. 
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Megger 
Norristown, PA U.S.A. 

Oil Circuit Breakers 
Capacitance and Power Factor Tests 

 
COMPANY DATE 
TEST LOCATION TESTED BY 
BREAKER IDENT. TEST SET NO. 
BREAKER MFR                                  TYPE AIR TEMPERATURE 
BREAKER KV                                     AMPS OIL TEMPERATURE 
BREAKER SERIAL NO. %RH 
BUSHING MFR                          TYPE              KV WEATHER 

 
CIRCUIT BREAKER OVERALL TESTS 

     TEST CONNECTIONS 
BUSHING 

    
% POWER FACTOR 

 EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
CB 

INSULATION 
TESTED 

φ TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE 
C(PF) 

 
MEASURED 

20°C 
%PF 

CORR 
FCTR 

 
mA 

 
WATTS 

ATION  
RATING 

1  C1G  GST 
GND 

1            

2 O C2G  GST 
GND 

2            

3 P C3G  GST 
GND 

3            

4 E C4G  GST 
GND 

4            

5 N C5G  GST 
GND 

5            

6  C6G  GST 
GND 

6            

7 C 
L 

C1G + C2G  GST 
GND 

1&2            

8 O 
S 

C3G + C4G  GST 
GND 

3&4            

9 E 
D 

C5G + C6G  GST 
GND 

5&6            

 
BUSHING & OIL TESTS 

TEST  BUSHING   
NO. NO. SER. NO. φ  
10 

 
1   UST 1   TAP         

11 
 

2   UST 2   TAP         

12 
 

3   UST 3   TAP         

13 
 

4   UST 4   TAP         

14 
 

5   UST 5   TAP         

15 
 

6   UST 6   TAP         

16 
 

 TANK 1 OIL  UST             

17 
 

 TANK 2 OIL  UST             

18 
 

 TANK 3 OIL  UST             

 
DIAGRAM 

 
Note: Circuit breaker open: bushing tests  
(Test No. 1, 2, 3, 4, 5, 6).  
Circuit breaker closed: tank tests  
(Test No. 7, 8, and 9). 

 
 
INSULATION RATING KEY 
G = GOOD 
D = DETERIORATED 
I = INVESTIGATE 
B =  BAD (REMOVE OR RECONDITION) 
 
INSULATION TESTED 
1 TO 6 = BUSHING TERMINALS 
G = GROUND 
 
Note: No. in ENG column is bushing energized,  
all other bushings must be floating. 

 
 
TANK LOSS INDEX 
TANK 1 = W7 -(W1 + W2) = 
TANK 2 = W8 - (W3 + W4) = 
TANK 3 = W9 - (W5 + W6) = 
 
Note: Subscripts are test no.s. Index may be 
positive or negative. 
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Megger 
Norristown, PA U.S.A. 

SF6 Dead Tank Circuit Breakers 
Capacitance and Power Factor Tests 

 
COMPANY DATE 
TEST LOCATION TESTED BY 
BREAKER IDENT. TEST SET NO. 
BREAKER MFR                                  TYPE AIR TEMPERATURE 
BREAKER KV                                     AMPS %RH 
BREAKER SERIAL NO. WEATHER 
BUSHING MFR                          TYPE              KV  

 
CIRCUIT BREAKER OVERALL TESTS 

     TEST CONNECTIONS 
BUSHING 

    
% POWER FACTOR 

 EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
CB 

INSULATION 
TESTED 

φ TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE 
C(PF) 

 
MEASURED 

20°C 
%PF 

CORR 
FCTR 

 
mA 

 
WATTS 

ATION  
RATING 

1  C1G  GST 
GND 

1            

2 O C2G  GST 
GND 

2            

3 P C3G  GST 
GND 

3            

4 E C4G  GST 
GND 

4            

5 N C5G  GST 
GND 

5            

6  C6G  GST 
GND 

6            

7  
O 

C12  UST 1   2         

8 P 
E 

C34  UST 3   4         

9 N 
 

C56  UST 5   6         

10 C 
L 

C1G + C2G  GST 
GND 

1&2            

11 O 
S 

C3G + C4G  GST 
GND 

3&4            

12 E 
D 

C5G + C6G  GST 
GND 

5&6            

 
BUSHING TESTS 

TEST  BUSHING   
NO. NO. SER. NO. φ  
13 

 
1   UST 1   TAP         

14 
 

2   UST 2   TAP         

15 
 

3   UST 3   TAP         

16 
 

4   UST 4   TAP         

17 
 

5   UST 5   TAP         

18 
 

6   UST 6   TAP         

 
DIAGRAM 

 
 
 
 

INSULATION RATING KEY 
G = GOOD 
D = DETERIORATED 
I = INVESTIGATE 
B =  BAD (REMOVE OR RECONDITION) 
 
INSULATION TESTED 
1 TO 6 = BUSHING TERMINALS 
G = GROUND 
 
Note: No. in ENG column is bushing energized 
in Tests 1 through 6, 10, 11 and 12. All other 
bushings must be floating. 

REMARKS 
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Megger 
Norristown, PA U.S.A. 

Vacuum Circuit Breakers 
Capacitance and Power Factor Tests 

 
COMPANY DATE 
TEST LOCATION TESTED BY 
BREAKER IDENT. TEST SET NO. 
BREAKER MFR                                  TYPE AIR TEMPERATURE 
BREAKER KV                                     AMPS %RH 
BREAKER SERIAL NO. WEATHER 
BUSHING MFR                          TYPE              KV  

 
CIRCUIT BREAKER OVERALL TESTS 

     TEST CONNECTIONS 
BUSHING 

    
% POWER FACTOR 

 EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
CB 

INSULATION 
TESTED 

φ TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE 
C(PF) 

 
MEASURED 

20°C 
%PF 

CORR 
FCTR 

 
mA 

 
WATTS 

ATION  
RATING 

1  C1G  GST 
GND 

1            

2 O C2G  GST 
GND 

2            

3 P C3G  GST 
GND 

3            

4 E C4G  GST 
GND 

4            

5 N C5G  GST 
GND 

5            

6  C6G  GST 
GND 

6            

7  
O 

C12  UST 1   2         

8 P 
E 

C34  UST 3   4         

9 N 
 

C56  UST 5   6         

 
BUSHING TESTS 

TEST  BUSHING   
NO. NO. SER. NO. φ  
10 

 
1   UST 1            

11 
 

2   UST 2            

12 
 

3   UST 3            

13 
 

4   UST 4            

14 
 

5   UST 5            

15 
 

6   UST 6            

 
DIAGRAM 

 
 
 
 

INSULATION RATING KEY 
G = GOOD 
D = DETERIORATED 
I = INVESTIGATE 
B =  BAD (REMOVE OR RECONDITION) 
 
INSULATION TESTED 
1 TO 6 = BUSHING TERMINALS 
G = GROUND 
 
Note: No. in ENG column is bushing energized 
in Tests 1 through 6, 10, 11 and 12. All other 
bushings must be floating. 

REMARKS 
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Megger 
Norristown, PA U.S.A. 

Air-Magnetic Circuit Breakers 
Capacitance and Power Factor Tests 

 
COMPANY DATE 
TEST LOCATION TESTED BY 
BREAKER IDENT. TEST SET NO. 
BREAKER MFR                                  TYPE AIR TEMPERATURE 
BREAKER KV                                     AMPS %RH 
BREAKER SERIAL NO. WEATHER 
BUSHING MFR                          TYPE              KV  

 
CIRCUIT BREAKER OVERALL TESTS 

     TEST CONNECTIONS 
BUSHING 

    
% POWER FACTOR 

 EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
CB 

INSULATION 
TESTED 

φ TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE 
C(PF) 

 
MEASURED 

20°C 
%PF 

CORR 
FCTR 

 
mA 

 
WATTS 

ATION  
RATING 

1  C1G  GST  
 

1  2          

2 O C2G  GST  
 

2  1          

3 P C3G  GST  
 

3  4          

4 E C4G  GST  
 

4  3          

5 N C5G  GST  
 

5  6          

6  C6G  GST  
 

6  5          

7  
O 

C12  UST 1   2         

8 P 
E 

C34  UST 3   4         

9 N 
 

C56  UST 5   6         

 
BUSHING TESTS 

TEST  BUSHING   
NO. NO. SER. NO. φ  
10 

 
1   UST 1            

11 
 

2   UST 2            

12 
 

3   UST 3            

13 
 

4   UST 4            

14 
 

5   UST 5            

15 
 

6   UST 6            

 
DIAGRAM 
 
 
 
 

INSULATION RATING KEY 
G = GOOD 
D = DETERIORATED 
I = INVESTIGATE 
B =  BAD (REMOVE OR RECONDITION) 
 
INSULATION TESTED 
1 TO 6 = BUSHING TERMINALS 
G = GROUND 
 
Note: No. in ENG column is bushing energized. 
 
Note: UST test checks grading capacitors 
across open contacts.  

REMARKS 
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Megger 
Norristown, PA U.S.A. 

Rotating Machinery 
(Motors and Generators) 

Capacitance and Power Factor Tests 
COMPANY DATE 
TEST LOCATION TESTED BY 
EQUIPMENT TESTED TEST SET NO. 
SERIAL NO.                               STATOR KV AIR TEMPERATURE 
KVA/MVA                                    HP STATOR TEMPERATURE 
RPM                                            ROTOR IN  OUT  % RH 
MFR                                            TYPE WEATHER 
STATOR INSUL                          AGE  

 
   TEST CONNECTIONS    % POWER FACTOR 

 EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
PHASE TESTED 

TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE  
C (PF) 

 
MEASURED 

%TIP 
UP 

REAC-
TOR 

 
mA 

 
WATTS 

ATION 
RATING 

1               

2               

3               

4               

5               

6               

7               

8               

9               

10               

11               

12               

13               

14               

15               

16               

17               

18               

19               

20               

 
INSULATION RATING KEY   EQUIVALENT CIRCUIT    REMARKS 
 
G =  GOOD 
D = DETERIORATED 
I =  INVESTIGATE 
B =    BAD (REMOVE OR RECONDITION) 
 
 
A = PHASE A WINDING 
B = PHASE B WINDING 
C = PHASE C WINDING 
G = GROUND 
NOTE: Short each phase winding on itself, if possible  
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Megger 

Norristown, PA U.S.A. 
Miscellaneous Equipment 

Capacitance and Power Factor Tests 
 

COMPANY DATE 
TEST LOCATION TESTED BY 
EQUIPMENT TESTED TEST SET NO. 
EQUIPMENT IDENT. AIR TEMPERATURE 
 OIL TEMPERATURE 
 % RH 
 WEATHER 

 
 

   TEST CONNECTIONS    % POWER FACTOR  EQUIV 10 KV 
 EQUIV 2.5 KV 

 
INSUL- 

TEST 
NO. 

 
INSULATION TESTED 

TEST 
MODE 

 
ENG 

 
GND 

 
GAR 

 
UST 

TEST 
KV 

CAPACITANCE  
C (PF) 

 
MEASURED 

20°C 
%PF 

CORR 
FCTR 

 
mA 

 
WATTS 

ATION 
RATING 

1 
 

              

2 
 

              

3 
 

              

4 
 

              

5 
 

              

6 
 

              

7 
 

              

8 
 

              

9 
 

              

10 
 

              

11 
 

              

12 
 

              

13 
 

              

14 
 

              

15 
 

              

16 
 

              

17 
 

              

18 
 

              

19 
 

              

20 
 

              

 
INSULATION RATING KEY       REMARKS 
 
G =  GOOD 
D = DETERIORATED 
I =  INVESTIGATE 
B =    BAD (REMOVE OR RECONDITION) 
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APPENDIX D 

Temperature Correction Tables 
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Table 1: Temperature Correction Factors for Liquids, Transformers, and Regulators 
 
           TEST TEMPERATURE              OIL-FILLED POWER TRANSFORMERS 
 

°C 
 
 
 
 
 0 
 1 
 2 
 3 
 4 
 5 
 6 
 7 
 8 
 9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35 
36 
37 
38 
39 
40 
42 
44 
46 
48 
50 
52 
54 
56 
58 
60 
62 
66 
70 

  °F 
 
 
 
 
 32.0 
 33.8 
 35.6 
 37.4 
 39.2 
 41.0 
 42.8 
 44.6 
 46.4 
 48.2 
 50.0 
 51.8 
 53.6 
 55.4 
 57.2 
 59.0 
 60.8 
 62.6 
 64.4 
 66.2 
 68.0 
 69.8 
 71.6 
 73.4 
 75.2 
 77.0 
 78.8 
 80.6 
 82.4 
 84.2 
 86.0 
 87.8 
 89.6 
 91.4 
 93.2 
 95.0 
 96.8 
 98.6 
100.4 
102.2 
104.0 
107.6 
111.2 
114.8 
118.4 
122.0 
125.6 
129.2 
132.8 
136.4 
140.0 
143.6 
150.8 
158.0 

ASKAREL 
FILLED 
XFMRS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.00 
0.95 
0.90 
0.85 
0.81 
0.76 
0.72 
0.68 
0.64 
0.60 
0.56 
0.53 
0.51 
0.48 
0.46 
0.44 
0.42 
0.40 
0.39 
0.37 
0.35 
0.33 
0.30 
0.28 
0.26 
0.24 
0.22 
0.21 
0.19 
0.18 
0.16 
0.15 
0.14 
0.12 

FREE-
BREATHING & 
CONSERVATOR 
TYPE 
 
 
1.56 
1.54 
1.52 
1.50 
1.48 
1.46 
1.45 
1.44 
1.43 
1.41 
1.38 
1.35 
1.31 
1.27 
1.24 
1.20 
1.16 
1.12 
1.08 
1.04 
1.00 
0.96 
0.91 
0.87 
0.83 
0.79 
0.76 
0.73 
0.70 
0.67 
0.63 
0.60 
0.58 
0.56 
0.53 
0.51 
0.49 
0.47 
0.45 
0.44 
0.42 
0.38 
0.36 
0.33 
0.30 
0.28 
0.26 
0.23 
0.21 
0.19 
0.17 
0.16 
0.14 
0.12 

SEALED & 
GASKET 
BLANKETED 
TYPE 
 
 
1.57 
1.54 
1.50 
1.47 
1.44 
1.41 
1.37 
1.34 
1.31 
1.28 
1.25 
1.22 
1.19 
1.16 
1.14 
1.11 
1.09 
1.07 
1.05 
1.02 
1.00 
0.98 
0.96 
0.94 
0.92 
0.90 
0.88 
0.86 
0.84 
0.82 
0.80 
0.78 
0.76 
0.75 
0.73 
0.71 
0.70 
0.69 
0.67 
0.66 
0.65 
0.62 
0.59 
0.56 
0.54 
0.51 
0.49 
0.47 
0.45 
0.43 
0.41 
0.40 
0.36 
0.33 

OIL-FILLED 
INSTRUMENT 
XFMRS 
 
 
 
1.67 
1.64 
1.61 
1.58 
1.55 
1.52 
1.49 
1.46 
1.43 
1.40 
1.36 
1.33 
1.30 
1.27 
1.23 
1.19 
1.16 
1.12 
1.08 
1.04 
1.00 
0.97 
0.93 
0.90 
0.86 
0.83 
0.80 
0.77 
0.74 
0.71 
0.69 
0.67 
0.65 
0.62 
0.60 
0.58 
0.56 
0.54 
0.52 
0.50 
0.48 
0.45 
0.42 
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Table 2: Bushing Temperature Correction Factors 
 
 TEST TEMPERATURE       G E N E R A L   E L E C T R I C 
 
°C 
 
 
 
 0 
 1 
 2 
 3 
 4 
 5 
 6 
 7 
 8 
 9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35 
36 
37 
38 
39 
40 
42 
44 
46 
48 
50 
52 
54 
56 
58 
60 
62 
66 
70 

 °F 
 
 
 
 32.0 
 33.8 
 35.6 
 37.4 
 39.2 
 41.0 
 42.8 
 44.6 
 46.4 
 48.2 
 50.0 
 51.8 
 53.6 
 55.4 
 57.2 
 59.0 
 60.8 
 62.6 
 64.4 
 66.2 
 68.0 
 69.8 
 71.6 
 73.4 
 75.2 
 77.0 
 78.8 
 80.6 
 82.4 
 84.2 
 86.0 
 87.8 
 89.6 
 91.4 
 93.2 
 95.0 
 96.8 
 98.6 
100.4 
102.2 
104.0 
107.6 
111.2 
114.8 
118.4 
122.0 
125.6 
129.2 
132.8 
136.4 
140.0 
143.6 
150.8 
158.0 

TYPE B 
 
 
 
1.09 
1.09 
1.09 
1.09 
1.09 
1.09 
1.08 
1.08 
1.08 
1.07 
1.07 
1.07 
1.06 
1.06 
1.05 
1.05 
1.04 
1.03 
1.02 
1.01 
1.00 
0.98 
0.97 
0.95 
0.93 
0.92 
0.90 
0.88 
0.85 
0.83 
0.81 
0.80 
0.77 
0.75 
0.73 
0.71 
0.69 
0.67 
0.65 
0.63 
0.61 

TYPE F 
 
 
 
0.93 
0.94 
0.95 
0.96 
0.97 
0.98 
0.98 
0.98 
0.99 
0.99 
0.99 
0.99 
0.99 
0.99 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
0.99 
0.99 
0.98 
0.97 
0.97 
0.96 
0.95 
0.94 
0.93 
0.92 
0.91 
0.89 
0.88 
0.87 
0.85 
0.84 
0.83 
0.81 
0.80 
0.78 
0.74 
0.70 
0.64 
0.58 
0.52 

TYPES 
L-LC 
LI-LM 
 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
0.99 
0.99 
0.99 
0.99 
0.98 
0.98 
0.97 
0.96 
0.96 
0.95 
0.95 
0.95 
0.94 
0.94 
0.93 
0.92 
0.91 
0.90 
0.89 
0.87 
0.85 
0.83 
0.82 
0.80 
0.79 
0.78 
0.77 
0.76 
0.74 
0.73 
0.70 
0.66 

TYPES 
OF-OFI 
OFM 
 
1.18 
1.17 
1.16 
1.15 
1.15 
1.14 
1.13 
1.12 
1.11 
1.11 
1.10 
1.09 
1.08 
1.07 
1.06 
1.05 
1.04 
1.03 
1.02 
1.01 
1.00 
0.99 
0.97 
0.96 
0.94 
0.93 
0.91 
0.90 
0.88 
0.87 
0.86 
0.84 
0.83 
0.81 
0.80 
0.78 
0.77 
0.75 
0.74 
0.72 
0.70 
0.67 
0.63 
0.61 
0.58 
0.56 
0.53 
0.51 
0.49 
0.46 
0.44 
0.40 
0.39 
0.36 

TYPES 
S-SI-SM 
 
 
1.26 
1.25 
1.24 
1.22 
1.21 
1.20 
1.19 
1.17 
1.16 
1.15 
1.14 
1.12 
1.11 
1.10 
1.08 
1.07 
1.06 
1.04 
1.03 
1.01 
1.00 
0.98 
0.97 
0.95 
0.93 
0.92 
0.90 
0.89 
0.87 
0.86 
0.84 
0.83 
0.81 
0.79 
0.77 
0.76 
0.74 
0.72 
0.70 
0.68 
0.67 
0.63 
0.60 
0.56 
0.53 
0.50 
0.47 
0.44 
0.41 
0.38 
0.36 
0.33 
0.28 
0.23 

TYPE U 
 
 
 
1.02 
1.02 
1.02 
1.02 
1.02 
1.02 
1.01 
1.01 
1.01 
1.01 
1.01 
1.01 
1.01 
1.01 
1.01 
1.01 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
0.99 
0.99 
0.99 
0.99 
0.99 
0.99 
0.99 
0.99 
0.99 
0.98 
0.98 
0.98 
0.98 
0.98 
0.98 
0.98 
0.98 
0.97 
0.97 
0.97 
0.97 
0.97 
0.96 
0.96 
0.96 
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Table 3:  Bushing Temperature Correction Factors 
 
    TEST TEMPERATURE                 LAPP INSULATOR COMPANY            MICANITE AND INSULATORS COMPANY 
 
°C 
 
 
 0 
 1 
 2 
 3 
 4 
 5 
 6 
 7 
 8 
 9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35 
36 
37 
38 
39 
40 
41 
42 
43 
44 
45 
46 
47 
48 
49 
50 
52 
54 
56 
58 
60 

 °F 
 
 
 32.0 
 33.8 
 35.6 
 37.4 
 39.2 
 41.0 
 42.8 
 44.6 
 46.4 
 48.2 
 50.0 
 51.8 
 53.6 
 55.4 
 57.2 
 59.0 
 60.8 
 62.6 
 64.4 
 66.2 
 68.0 
 69.8 
 71.6 
 73.4 
 75.2 
 77.0 
 78.8 
 80.6 
 82.4 
 84.2 
 86.0 
 87.8 
 89.6 
 91.4 
 93.2 
 95.0 
 96.8 
 98.6 
100.4 
102.2 
104.0 
105.8 
107.6 
109.4 
111.2 
113.0 
114.8 
116.6 
118.4 
120.2 
122.0 
125.6 
129.2 
132.8 
136.4 
140.0 

CLASS P O C 
15 TO 69 KV 
 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 
1.00 

P R C 
 
 
0.80 
 
 
 
 
0.86 
 
 
 
 
0.91 
 
 
 
 
0.95 
 
 
 
 
1.00 
 
 
 
 
1.04 
 
 
 
 
1.08 
 
 
 
 
1.11 
 
 
 
 
1.13 
 
 
 
 
1.13 
 
 
 
 
1.11 
 
 
 
 
1.01 

25 TO 69 KV 
 
 
1.55 
 
 
 
 
1.40 
 
 
 
 
1.25 
 
 
 
 
1.12 
 
 
 
 
1.00 
 
 
 
 
0.89 
 
 
 
 
0.80 
 
 
 
 
0.72 
 
 
 
 
0.64 
 
 
 
 
0.56 
 
 
 
 
0.50 

ABOVE 69 KV 
 
 
1.13 
 
 
 
 
1.09 
 
 
 
 
1.06 
 
 
 
 
1.03 
 
 
 
 
1.00 
 
 
 
 
0.97 
 
 
 
 
0.94 
 
 
 
 
0.91 
 
 
 
 
0.88 
 
 
 
 
0.86 
 
 
 
 
0.83 
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Table 4: Bushing Temperature Correction Factors 
 
TEST TEMPERATURE    O H I O   B R A S S   W E S T I N G H O U S E 
 
°C 
 
 
 
 
 
 0 
 1 
 2 
 3 
 4 
 5 
 6 
 7 
 8 
 9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35 
36 
37 
38 
39 
40 
42 
44 
46 
48 
50 
52 
54 
50 
58 
60 
62 
66 
70 

 °F 
 
 
 
 
 
 32.0 
 33.8 
 35.6 
 37.4 
 39.2 
 41.0 
 42.8 
 44.6 
 46.4 
 48.2 
 50.0 
 51.8 
 53.6 
 55.4 
 57.2 
 59.0 
 60.8 
 62.6 
 64.4 
 66.2 
 68.0 
 69.8 
 71.6 
 73.4 
 75.2 
 77.0 
 78.8 
 80.6 
 82.4  
 84.2 
 86.0 
 87.8 
 89.6 
 91.4 
 93.2 
 95.0 
 96.8 
 98.6 
100.4 
102.2 
104.0 
107.6 
111.2 
114.8 
118.4 
122.0 
125.6 
129.2 
132.8 
136.4 
140.0 
143.6 
150.8 
158.0 

CLASS 
G & l 
46 TO 
138 KV 
 
 
1.54 
1.50 
1.47 
1.43 
1.40 
1.37 
1.34 
1.32 
1.29 
1.26 
1.24 
1.21 
1.18 
1.16 
1.14 
1.11 
1.09 
1.07 
1.04 
1.02 
1.00 
0.98 
0.95 
1.93 
0.91 
0.89 
0.88 
0.86 
0.84 
0.82 
0.80 
0.79 
0.77 
0.75 
0.74 
0.72 
0.71 
0.69 
0.68 
0.66 
0.65 

CLASS 
L 7.5 
TO 
34.5 
KV 
 
1.29 
1.27 
1.26 
1.25 
1.24 
1023 
1.21 
1.20 
1.19 
1.17 
1.16 
1.14 
1.12 
1.11 
1.09 
1.07 
1.06 
1.04 
1.03 
1.02 
1.00 
0.99 
0.97 
0.96 
0.94 
0.93 
0.91 
0.90 
0.88 
0.87 
0.86 
0.84 
0.83 
0.82 
0.80 
0.79 
0.78 
0.76 
0.75 
0.74 
0.72 

CLASS 
GK 69 
TO 196 
KV 
 
 
0.90 
0.90 
0.91 
0.91 
0.91 
0.91 
0.92 
0.92 
0.92 
0.93 
0.93 
0.94 
0.94 
0.95 
0.95 
0.96 
0.97 
0.97 
0.98 
0.99 
1.00 
1.01 
1.02 
1.03 
1.04 
1.05 
1.06 
1.08 
1.09 
1.10 
1.11 
1.12 
1.13 
1.14 
1.15 
1.16 
1.17 
1.18 
1.19 
1.20 
1.21 
1.22 
1.24 
1.26 
1.27 
1.29 
1.30 
1.31 
1.33 
1.34 
1.35 

CLASS 
LK 23 
TO 69 
KV 
 
 
0.85 
0.86 
0.86 
0.86 
0.87 
0.88 
0.89 
0.89 
0.90 
0.91 
0.92 
0.92 
0.93 
0.94 
0.95 
0.95 
0.96 
0.97 
0.98 
0.99 
1.00 
1.01 
1.02 
1.03 
1.04 
1.05 
1.06 
1.07 
1.08 
1.09 
1.10 
1.11 
1.12 
1.13 
1.14 
1.15 
1.15 
1.16 
1.17 
1.18 
1.18 
1.19 
1.20 
1.21 
1.21 
1.22 
1.22 
1.22 
1.22 
1.21 
1.21 

TYPE D 
 
 
 
 
 
1.26 
1.24 
1.23 
1.22 
1.20 
1.19 
1.18 
1.16 
1.15 
1.14 
1.12 
1.10 
1.09 
1.07 
1.06 
1.05 
1.04 
1.03 
1.02 
1.01 
1.00 
0.99 
0.97 
0.96 
0.95 
0.94 
0.92 
0.91 
0.90 
0.89 
0.87 
0.86 
0.85 
0.83 
0.82 
0.81 
0.79 
0.78 
0.77 
0.75 
0.74 
0.71 
0.69 
0.65 
0.62 
0.59 
0.58 
0.57 
0.56 
0.55 
0.54 
0.53 
0.51 
0.49 

CONDE
N-SER 
TYPE O 
 
 
 
1.61 
1.56 
1.52 
1.48 
1.44 
1.40 
1.36 
1.33 
1.30 
1.26 
1.23 
1.21 
1.18 
1.16 
1.13 
1.11 
1.09 
1.06 
1.04 
1.02 
1.00 
0.98 
0.96 
0.94 
0.92 
0.90 
0.88 
0.86 
0.84 
0.83 
0.81 
0.79 
0.77 
0.75 
0.74 
0.72 
0.70 
0.69 
0.67 
0.66 
0.64 
0.62 
0.59 
0.56 
0.53 
0.51 
0.50 
0.48 
0.47 
0.46 
0.45 
0.44 
0.42 
0.40 

TYPE O 
 
 
 
 
 
1.11 
1.10 
1.10 
1.09 
1.09 
1.08 
1.08 
1.07 
1.07 
1.06 
1.05 
1.05 
1.04 
1.04 
1.03 
1.03 
1.02 
1.02 
1.01 
1.01 
1.00 
0.99 
0.99 
0.98 
0.98 
0.97 
0.96 
0.96 
0.95 
0.94 
0.94 
0.93 
0.93 
0.92 
0.92 
0.91 
0.91 
0.90 
0.89 
0.88 
0.88 
0.87 
0.86 
0.85 
0.83 
0.82 
0.81 
0.80 
0.79 
0.78 
0.77 
0.76 
0.74 
0.73 
 


